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Audience for This Guide

Welcome to Release 11i of the Application Data Exchange and
Hierarchy Diagrammers user guide.

This guide assumes you have a working knowledge of the following:

• The principles and customary practices of your business area.

• Application Data Exchange and Hierarchy Diagrammers

If you have never used Application Data Exchange and
Hierarchy Diagrammers, we suggest you attend one or more of
the Application Data Exchange and Hierarchy Diagrammers
training classes available through Oracle University.

• The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user
interface, read the Oracle Applications User Guide.

See Other Information Sources for more information about Oracle
Applications product information.

How To Use This Guide

This guide contains the information you need to understand and use
Application Data Exchange and Hierarchy Diagrammers.

This preface explains how this user guide is organized and introduces
other sources of information that can help you.  This guide contains the
following chapters:

• Chapter 1 provides an overview of Application Data Exchange,
and explains how you can use it to link Oracle HRMS and Oracle
Training Administration (OTA) to desktop tools such as word
processors, spreadsheets and data query tools. It also describes
the three modes of working with ADE: standalone, application
and Letter request.

• Chapter 2 explains how to use Application Data Exchange to
perform data queries, and how to export data in standalone
mode.

• Chapter 3 explains how to use Application Data Exchange to
extract data from Oracle HRMS or OTA then modify the data
with desktop spreadsheets, word processors or other
applications. You can then upload the data you have modified
back to Oracle HRMS or OTA. It also describes how to perform
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what–if calculations on your organizational data without
affecting the information that is held on your database.

• Chapter 4 explains how to generate standard letters and requests
you need in Oracle HRMS and OTA. It describes the three ways
of generating letters: standalone, application and Letter request.

• Chapter 5 describes how to setup ADE for each PC you want to
use. This is typically a task for a System Administrator and
Database Administrator.

• Chapter 6 describes how to graphically view and create
hierarchy diagrams for  organizations and positions using Oracle
HRMS Hierarchy Diagrammers.

Finding Out What’s New

From the HTML help window for Application Data Exchange and
Hierarchy Diagrammers, choose the section that describes new features
or what’s new from the expandable menu.  This section describes:

• New features in 11i. This information is updated for each new
release of Application Data Exchange and Hierarchy
Diagrammers.

• Information about any features that were not yet available when
this user guide was printed.  For example, if your system
administrator has installed software from a mini pack as an
upgrade, this document describes the new features.

Other Information Sources

You can choose from many sources of information, including online
documentation, training, and support services, to increase your
knowledge and understanding of Application Data Exchange and
Hierarchy Diagrammers.

If this guide refers you to other Oracle Applications documentation,
use only the Release 11i versions of those guides unless we specify
otherwise.
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Online Documentation

All Oracle Applications documentation is available online (HTML and
PDF).  The technical reference guides are available in paper format
only.  Note that the HTML documentation is translated into over
twenty languages.

The HTML version of this guide is optimized for onscreen reading, and
you can use it to follow hypertext links for easy access to other HTML
guides in the library.  When you have an HTML window open, you can
use the features on the left side of the window to navigate freely
throughout all Oracle Applications documentation.

• You can use the Search feature to search by words or phrases.

• You can use the expandable menu to search for topics in the
menu structure we provide.  The Library option on the menu
expands to show all Oracle Applications HTML documentation.

You can view HTML help in the following ways:

• From an application window, use the help icon or the help menu
to open a new Web browser and display help about that window.

• Use the documentation CD.

• Use a URL provided by your system administrator.

Your HTML help may contain information that was not available when
this guide was printed.

Related User Guides

Application Data Exchange and Hierarchy Diagrammers shares
business and setup information with other Oracle Applications
products.  Therefore, you may want to refer to other user guides when
you set up and use Application Data Exchange and Hierarchy
Diagrammers.

You can read the guides online by choosing Library from the
expandable menu on your HTML help window, by reading from the
Oracle Applications Document Library CD included in your media
pack, or by using a Web browser with a URL that your system
administrator provides.

If you require printed guides, you can purchase them from the Oracle
store at http://oraclestore.oracle.com.
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User Guides Related to All Products

Oracle Applications User Guide

This guide explains how to navigate the system, enter data, and query
information, and introduces other basic features of the GUI available
with this release of Application Data Exchange and Hierarchy
Diagrammers (and any other Oracle Applications product).

You can also access this user guide online by choosing ”Getting Started
and Using Oracle Applications” from the Oracle Applications help
system.

Oracle Alert User Guide

Use this guide to define periodic and event alerts that monitor the
status of your Oracle Applications data.

Oracle Applications Implementation Wizard User Guide

If you are implementing more than one Oracle product, you can use the
Oracle Applications Implementation Wizard to coordinate your setup
activities.  This guide describes how to use the wizard.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle
Applications development staff.  It describes the Oracle Application
Object Library components needed to implement the Oracle
Applications user interface described in the Oracle Applications User
Interface Standards.  It also provides information to help you build your
custom Oracle Developer forms so that they integrate with Oracle
Applications.

Oracle Applications User Interface Standards

This guide contains the user interface (UI) standards followed by the
Oracle Applications development staff.  It describes the UI for the
Oracle Applications products and how to apply this UI to the design of
an application built by using Oracle Forms.
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User Guides Related to This Product

Using Oracle HRMS – The Fundamentals

This user guide explains how to setup and use enterprise modeling,
organization management, and cost analysis.  It also includes
information about defining payrolls.

Managing People Using Oracle HRMS

Use this guide to find out about using employee management,
recruitment activities, career management, and budgeting.

Running Your Payroll Using Oracle HRMS

This user guide provides information about wage attachments, taxes
and social insurance, the payroll run, and other processes.

Managing Compensation and Benefits Using Oracle HRMS

Use this guide to learn about compensation setup, entry and analysis,
setting up basic, standard and advanced benefits, salary
administration, and absence management and PTO accruals.

Customizing, Reporting and System Administration in Oracle HRMS

This guide provides information about extending and customizing
Oracle HRMS, managing security, auditing, information access, and
letter generation.

Implementing Oracle HRMS

This user guide explains the setup procedures you need to do in order
to successfully implement Oracle HRMS in your enterprise.

Implementing Oracle Self–Service Human Resources (SSHR)

This guide provides information about setting up the self–service
human resources management functions for managers and employees.
Managers and employees can then use an intranet and Web browser to
have easy and intuitive access to personal and career management
functionality
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Using Oracle FastFormula

This guide provides information about writing, editing, and using
formulas to customize your system.  Oracle FastFormula provides a
simple way to write formulas using English words and basic
mathematical functions. For example, Oracle FastFormula enables you
to specify elements in payroll runs or create rules for PTO and accrual
plans.

Using Oracle Training Administration (OTA)

This guide provides information about how to set up and use Oracle
Training Administration to facilitate your training and certification
business.

Using Oracle SSP/SMP

This guide provdes information about setting up and using Oracle
SSP/SMP to meet your statutory sick pay and statutory maternity pay
obligations.

Using Application Data Exchange and Hierarchy Diagrammers

This guide provides information about using Application Data
Exchange to view HRMS data with desktop tools, and upload revised
data to your application.  This guide also provides information about
using Hierarchy Diagrammers to view hierarchy diagrams for
organizations and positions.

Oracle Business Intelligence System Implementation Guide

This guide provides information about implementing Oracle Business
Intelligence (BIS) in your environment.

BIS 11i User Guide Online Help

This guide is provided as online help only from the BIS application and
includes information about intelligence reports, Discoverer workbooks,
and the Performance Management Framework.

Using Oracle Time Management

This guide provides information about capturing work patterns such as
shift hours so that this information can be used by other applications
such as General Ledger.
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Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup, and reference
information for the Application Data Exchange and Hierarchy
Diagrammers implementation team, as well as for users responsible for
the ongoing maintenance of Oracle Applications product data.  This
guide also provides information on creating custom reports on
flexfields data.

Installation and System Administration Guides

Oracle Applications Concepts

This guide provides an introduction to the concepts, features,
technology stack, architecture, and terminology for Oracle Applications
Release 11i.  It provides a useful first book to read before an installation
of Oracle Applications.  This guide also introduces the concepts behind,
and major issues, for Applications–wide features such as Business
Intelligence (BIS), languages and character sets, and self–service
applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products.  In Release 11i, much of the installation process
is handled using Oracle One–Hour Install, which minimizes the time it
takes to install Oracle Applications and the Oracle 8i Server technology
stack by automating many of the required steps.  This guide contains
instructions for using Oracle One–Hour Install and lists the tasks you
need to perform to finish your installation.  You should use this guide
in conjunction with individual product user guides and
implementation guides.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications
Release 10.7 or Release 11.0 products to Release 11i.  This guide
describes the upgrade process in general and lists database upgrade
and product–specific upgrade tasks.  You must be at either Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0 to upgrade to
Release 11i.  You cannot upgrade to Release 11i directly from releases
prior to 10.7.
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Using the AD Utilities

Use this guide to help you run the various AD utilities, such as
AutoInstall, AutoPatch, AD Administration, AD Controller, Relink,
and others.  It contains how–to steps, screenshots, and other
information that you need to run the AD utilities.

Oracle Applications Product Update Notes

Use this guide as a reference if you are responsible for upgrading an
installation of Oracle Applications.  It provides a history of the changes
to individual Oracle Applications products between Release 11.0 and
Release 11i.  It includes new features and enhancements and changes
made to database objects, profile options, and seed data for this
interval.

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle
Applications System Administrator.  It contains information on how to
define security, customize menus and online help, and manage
processing.

Oracle HRMS Applications Technical Reference Guide

This reference guide contains database diagrams and a detailed
description of database tables, forms, reports, and programs for Oracle
HRMS, including Application Data Exchange and Hierarchy
Diagrammers and related applications.  This information helps you
convert data from your existing applications, integrate Application
Data Exchange and Hierarchy Diagrammers with non–Oracle
applications, and write custom reports for Application Data Exchange
and Hierarchy Diagrammers.

You can order a technical reference guide for any product you have
licensed.  Technical reference guides are available in paper format only.

Oracle Workflow Guide

This guide explains how to define new workflow business processes as
well as customize existing Oracle Applications–embedded workflow
processes.  You also use this guide to complete the setup steps
necessary for any Oracle Applications product that includes
workflow–enabled processes.
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Training and Support

Training

We offer a complete set of training courses to help you and your staff
master Oracle Applications.  We can help you develop a training plan
that provides thorough training for both your project team and your
end users.  We will work with you to organize courses appropriate to
your job or area of responsibility.

Training professionals can show you how to plan your training
throughout the implementation process so that the right amount of
information is delivered to key people when they need it the most.  You
can attend courses at any one of our many Educational Centers, or you
can arrange for our trainers to teach at your facility.  We also offer Net
classes, where training is delivered over the Internet, and many
multimedia–based courses on CD. In addition, we can tailor standard
courses or develop custom courses to meet your needs.

Support

From on–site support to central support, our team of experienced
professionals provides the help and information you need to keep
Application Data Exchange and Hierarchy Diagrammers working for
you.  This team includes your Technical Representative, Account
Manager, and Oracle’s large staff of consultants and support specialists
with expertise in your business area, managing an Oracle server, and
your hardware and software environment.

Do Not Use Database Tools to Modify Oracle Applications Data

We STRONGLY RECOMMEND that you never use SQL*Plus, Oracle
Data Browser, database triggers, or any other tool to modify Oracle
Applications tables, unless we tell you to do so in our guides.

Oracle provides powerful tools you can use to create, store, change,
retrieve, and maintain information in an Oracle database.  But if you
use Oracle tools such as SQL*Plus to modify Oracle Applications data,
you risk destroying the integrity of your data and you lose the ability to
audit changes to your data.

Because Oracle Applications tables are interrelated, any change you
make using an Oracle Applications form can update many tables at
once.  But when you modify Oracle Applications data using anything
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other than Oracle Applications forms, you might change a row in one
table without making corresponding changes in related tables.  If your
tables get out of synchronization with each other, you risk retrieving
erroneous information and you risk unpredictable results throughout
Oracle Applications.

When you use Oracle Applications forms to modify your data, Oracle
Applications automatically checks that your changes are valid.  Oracle
Applications also keeps track of who changes information.  But, if you
enter information into database tables using database tools, you may
store invalid information.  You also lose the ability to track who has
changed your information because SQL*Plus and other database tools
do not keep a record of changes.

About Oracle

Oracle Corporation develops and markets an integrated line of
software products for database management, applications
development, decision support and office automation, as well as Oracle
Applications. Oracle Applications provides the E–Business Suite, a
fully integrated suite of more than 70 software modules for financial
management, internet procurement, business intelligence, supply chain
management, manufacturing, project systems, human resources and
sales and service management.

Oracle products are available for mainframes, minicomputers, personal
computers, network computers, and personal digital assistants,
enabling organizations to integrate different computers, different
operating systems, different networks, and even different database
management systems, into a single, unified computing and information
resource.

Oracle is the world’s leading supplier of software for information
management, and the world’s second largest software company. Oracle
offers its database, tools, and application products, along with related
consulting, education and support services, in over 145 countries
around the world.

Your Feedback

Thank you for using Application Data Exchange and Hierarchy
Diagrammers and this user guide.
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We value your comments and feedback.  This guide contains a
Reader’s Comment Form you can use to explain what you like or
dislike about Application Data Exchange and Hierarchy Diagrammers
or this user guide.  Mail your comments to the following address or call
us directly at (650) 506–7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
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Introduction to Application Data Exchange

How Does ADE Support My Business?

Application Data Exchange (ADE) links Oracle HRMS and Oracle
Training Administration (OTA) to desktop tools such as word
processors, spreadsheets and data query tools. This enables HR
professionals to manipulate HR information, with familiar desktop
tools, then upload the data back to HRMS and OTA.

What Range of Functionality Does ADE Provide?

 ADE provides an extensive range of functionality. You can:

• Query your applications database

• Export data from your application to ADE

• Preview exported data using the ADE built–in spreadsheet

• Manipulate and modify applications data

• Upload modified data from ADE to the application

• Generate standard letters

• Launch other applications, for example:

– A word processor or spreadsheet application

– An Oracle reporting tool, such as Discoverer

– A Hierarchy Diagrammer to graphically display an
organization or position hierarchy

– Any other program defined on your system
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Application Data Exchange Overview

Application Data Exchange enables you to view HRMS data with
desktop tools, and upload revised data to your application.

ADE Environment

Three Modes of Working with ADE

You can use ADE in one of three modes:

• Standalone mode

• Application mode

• Letter request mode

Standalone mode is where you run ADE from your PC desktop
without accessing either HRMS or OTA. Use standalone mode to:

• Access query–only data.

• Select a predefined query and export to ADE all fields retrieved
by the query.

• Attach search conditions to a predefined query.

• Manipulate the data at the same time as querying.

• Save a query definition so you can run the query without having
to redefine it.

Application mode is where you run ADE from a button on your HRMS
or OTA application toolbar. Use application mode to:

• Export data that uses folder definitions

• Make use of all HRMS and OTA functionality rather than
predefined queries

• Perform queries within HRMS and OTA and then export the
current record to ADE, or rerun the previous query so it can be
exported

Letter request mode is where you run ADE from the Request Letter
window in Oracle HRMS or OTA. Use letter request mode to produce
mail–merged standard letters for recruitment or enrollment. For
example, a letter to trainees to announce the cancellation of a training
course. You can also generate automatic Requests for letters using
associated assignment or enrollment statuses for each standard letter.

Note:  You can also perform a mail merge from standalone
mode or application mode by exporting the data for your
standard letter and then launching Microsoft Word.
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Supported Platforms

ADE can run on Windows 95, Windows 98 or Windows NT 3.5 or 4.0.

Compatible Products

The following products are compatible with ADE:

• Spreadsheets – Microsoft Excel 95 and 97 or Lotus 1–2–3 Version
5.0

• Word Processors – Microsoft Word 95 and 97
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Starting ADE

To start ADE in standalone mode, select the ADE icon on your PC
desktop.

Note:  Access to your database is controlled by the same
security as Oracle HRMS and OTA, which is set up by your
System Administrator.

To start ADE in letter request mode, select the ADE spreadsheet icon
after you queried and opened the Request Letter window in Oracle
HRMS or OTA.

Starting ADE in Standalone Mode

� To start ADE in standalone mode:

1. Select the ADE icon.

2. Enter your username and password and choose OK to confirm.

Note:  The Oracle Applications Signon window includes an
Options button. The Options button enables you to select the
executable files for your desktop and Oracle applications. You
can modify paths without having to log on to ADE.

3. Select a responsibility, if prompted.

The responsibility you select restricts access to your database and is
controlled by the same security as Oracle HRMS and OTA. You can
select any responsibility that you use to access these applications.

If you only have one responsibility, you are connected to your
database with that responsibility.

4. Optionally, set an effective date in the Session Date field.

The session date defaults to the current date. You are able to change
the effective date at any point during an ADE session. However, data
with an earlier date than the effective date will not be visible to ADE.
And, if you attempt to query or load batches of data that contain
data created earlier than your current effective date, then it is likely
that the entire query or load will fail.

Starting ADE in Application Mode

� To start ADE in application mode:

1. Query some data.



1 – 6 Using Application Data Exchange and Hierarchy Diagrammers

2. Select the ADE spreadsheet icon found on the Oracle HRMS or
OTA application toolbar. You can also select, Tools/Export Data
from the Oracle HRMS or OTA pull down menus.

Note:  The ADE  spreadsheet icon is shaded until you have
queried some data.

Starting ADE in Letter Request Mode

� To start ADE in Letter Request Mode:

1. Query some data in the Request Letter window.

2. Select the ADE spreadsheet icon found on the Oracle HRMS or
OTA application toolbar.
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Start Another Application from ADE in Application Mode

You can launch the following applications from ADE:

• A spreadsheet

• A word processor

• Oracle Discoverer

• The HR Organization or Position Hierarchy Diagrammer.  If you
can launch the diagrammers, you may only be able to view
hierarchies (without making changes to them), depending on the
access for your responsibility.

• Any other program you or your System Administrator has
defined using the ADE Options button in ADE standalone mode.
The program may be an Oracle application, for example,
SQL*Plus, or a third party program.

Applications can be opened directly without transferring any data to
the application. Or indirectly and transferring data from your database
to the application.

You open an application directly by selecting the program you want to
run from the Fetch Data window. You open an application indirectly by
first querying some data, ADE transfers all the records for the last
query performed in your application or a single record from the current
window, and then viewing the data using the built–in ADE
spreadsheet. You can then launch, for example, a word processor or
spreadsheet application and analyze, process or mail merge the data.
You may also upload the data back to the database, depending on
setup.

The applications you can launch directly from ADE are defined by your
System Administrator for your responsibility during setup.  If you
cannot access an option, it may be because the paths have not been
defined or the option is not available for your responsibility.  You can
check the paths defined for programs on your PC using the Paths page
in the ADE Options window.

See: Defining Paths: page 5 – 29

If access to applications is restricted for your responsibility, your
System Administrator must change the functions defined for your
responsibility to change your access to them.  For example, access to
the Hierarchy Diagrammers is controlled by responsibility.

� To launch an application directly from ADE:

1. Choose an option from the ADE Fetch Data window, to select the
program you want to run.
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2. Choose the Start button to launch the program. ADE is iconized
while the program is running.

Note:  When you run an Oracle program, you are connected
using the same secure user Oracle ID you used to access Oracle
HRMS or Oracle Training Administration.

� To launch an application indirectly from ADE:

1. Choose a style from the ADE Fetch Data window.

2. Select None to transfer data to the built–in ADE spreadsheet.

3. Launch an application to process the data.
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Data Queries

Can You Use Predefined Styles?

Yes – ADE provides access to predefined styles, in effect predefined
queries, of commonly used categories of data. This is useful when you
need to refer to a broad range of data.

Can You Specify Conditions before Querying Data?

You can use relational operators to narrow the scope of a search. This
enables you to retrieve data that answers a particular search need.

How Can You Use Exported Data?

You can use exported data in several ways. You can use the built in
ADE spreadsheet to preview exported data. Or, you can connect to a
desktop spreadsheet application and perform the full range of
information analysis available with spreadsheet tools.
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Data Queries Overview

Using Spreadsheets With ADE

ADE includes a simple built–in spreadsheet, in the Data Preview
window, to preview any data retrieved by a query. You can also export
data to a spreadsheet application. Doing this enables you to use the
special features of your spreadsheet to manipulate information for
analysis and graphical representation.

In addition to enabling the export of data, some ADE styles, predefined
queries, enable you to make changes to data in the spreadsheet, over
time, and upload the modified data back to your database.

You can transfer data from your database to a spreadsheet in both
standalone or application mode.

Using ADE in standalone mode, you access your database directly,
without opening the Oracle HRMS or OTA application, to export data.
You select a style to retrieve information from your database and then
refine the selection of data and specify the order of data returned by the
query.

See: Exporting Data Using ADE in Standalone Mode: page 2 – 3

Using ADE in application mode, you retrieve and export information
from your database, within the Oracle HRMS or OTA application. You
select a style to retrieve a set of records or a single record from the
current application window.

Exporting Data Using ADE in Standalone Mode

All the queries you perform in standalone mode use predefined styles.
Styles are predefined queries. Some styles are supplied on installation
and others are created by your System Administrator. You can use
predefined styles to export data in one of the following ways:

• Export the data without specifying further conditions for the
query

• Specify conditions for the query and then export the data

Exporting Data without Specifying Conditions

You retrieve information using ADE in standalone mode, by
performing queries on your database.

You perform a query by selecting a query from the Query Details field
in the Define Query window.
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Comparison Operators

The table below lists the comparison operators you can use to specify a
value or range of values for a query condition:

Operator Meaning

= equal to

<> not equal to

> greater than

< less than

>= greater than or equal to

<= less than or equal to

The default operator for all query conditions selects items equal to the
value.

Previewing Exported Data

You use the Data Preview window to view data exported from your
database using ADE.  The Data Preview window displays data
transferred to the built–in ADE spreadsheet.

The format of the Data Preview window and the tasks you can
perform, depend on how you are using ADE (in application or
standalone mode), and whether the style used to export the data has
been enabled so you can upload modified query data to your database.

You can also use the Data Preview window to:

• Print the query data.

• Launch a word processor to perform a mail merge or a
spreadsheet application to analyze the data.

• Save a query so you can rerun it.  This option is only available
using ADE in standalone mode.

• Import query data transferred to a spreadsheet and upload the
modified data to your database.
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Selecting a Query

You must select a query, or style, from those defined on your system.
For example, a style called ‘US Employees’ might return details of each
US employee entered on your database.

You can perform a default transfer for the query and view it in the Data
Preview window to see all the data retrieved by the query.

� To select a query:

1. Select a query from the Query Details pull–down list, using ADE in
standalone mode, from the Define Query window.

2. Change the date for the query, if required. The session date
determines effective date.

3. Export data, if required, by selecting the Fetch button.



2 – 6 Using Application Data Exchange and Hierarchy Diagrammers

Specifying Search Conditions

The Define Query window enables you to select a predefined query
and define conditions for the query. You can specify a single search
condition or multiple search conditions to refine the selection of data
retrieved by the query.

� To specify search conditions:

1. Select a query from the Query Details field in the Define Query
window.

2. Select a search condition from the Criteria list.  For example, select
‘City‘ to query a specific city name from the US Employees
predefined query.

3. Drag the button next to the selected query condition, onto the
white bar in the Selection Details panel.

Note:  You must ensure the hand pointer is over the white bar
before dropping the selected query condition.

4. Use the Query Value window to enter a value for the query
condition. Or select a value using the find button if an LoV has
been defined.

5. Use the spin box to select a comparison operator.

6. You can specify further conditions for a query to define multiple
search conditions.

Multiple search conditions combine single search conditions using
the following operators.

• AND

Both search conditions must be matched to return records for the
query

• OR

Either search conditions must be matched to return records for
the query

To specify multiple search conditions:

• Select another search condition from the Criteria list and drag it
over the Selection Details panel.

• Drop the search condition over one of the white bars.

7. You can continue combining any number of search conditions to
construct compound expressions for the query.

8. To view the full details of a search condition, or delete or modify a
condition, double–click the search condition in the Selection Details
panel. The query condition is displayed in the Edit Cell window.
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Specifying the Data Order

The Define Query window enables you to select a predefined query
and define conditions for the query. You can specify the data order
returned by the query.

� To specify the order of data returned by the query:

1. Select a query condition from the Criteria list in the Define Query
window. Drag the query condition onto one of the three order
fields in the Fetch Order panel.

Note:  The far left field takes precedence if you use multiple
search criteria to specify the order.

2. Click the arrow adjacent to the order field to change the sort order.
By default, the sort order is ascending.
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Exporting the Data for a Query

� To export the data for a query:

�  Select the Fetch button to export data from the Define Query
window. The data is then transferred to the built–in ADE
spreadsheet in the Data Preview window.
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Specifying a Query Value

Use the Query Value window to specify the detail for a query
condition. The Query Value window is displayed automatically when
you select a query condition in the Define Query window.

The Query Value window enables you to:

• Select a value from a predefined list.

• Enter a date value.

• Enter a text string.

• Enter a numeric value.

The format of the window depends on the query condition. For
example, in date query you can only enter data in a date format,
DD/MM/YYYY.

You can select a comparison operator to complete the definition for a
condition with the spin box adjacent to the value field. The operators
you can select for a text condition, depend on the type of query
condition you are defining (text string, date, numeric value, predefined
list). See the list of: Comparison Operators: page 2 – 4

The default operator for all query conditions selects items equal to the
value.

� To specify a query value:

1. Click the Find button to display the list if you are selecting a value
from a predefined list. You can enter a text string with wildcards to
refine the list of items displayed.

2. Enter the date in the value field if you are specifying a date value.
To specify a date range using a start date or end date, select a
comparison operator. For example, you could specify >=
21/01/1996 to query on Hire Date and retrieve details of
employees hired after this date.

3. Enter text in the value field if you are specifying a text string. You
can include wildcards in the string and select a comparison
operator to retrieve data for a range of values.

Note:  If you use wildcards to specify a text condition, a ’like‘
operation is performed.

4. Enter the number in the value field if you are entering a numeric
value. Select a comparison operator to retrieve data for a numeric
range.

5. Choose OK to confirm the query value.



2 – 10 Using Application Data Exchange and Hierarchy Diagrammers

Saving a Query

You can save a query you have performed and rerun it later. A saved
query includes all the search criteria specified for the original query, as
well as the data formatting information and other configurable options
for standalone queries.

Note:  The save query option is only available in standalone
mode.

� To save a query:

1. Query your database using ADE in standalone mode. See:
Exporting Data Using ADE in Standalone Mode: page 2 – 3

Data is transferred to the built–in ADE spreadsheet and displayed
in the Data Preview window.

2. Click the Save button in the Data Preview window.

3. Enter a description for the query in the Save Query Definition
window.

4. Click OK to save the query definition.
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Rerunning or Deleting a Saved Query

Use the Load or Delete Query window to load or delete a saved query.
Once you have loaded a saved query, you can rerun it using the same
query criteria and other details specified for the original query.

You can only run or or delete a saved query in standalone mode.

� To load and rerun a saved query:

1. Open the Load or Delete Query window.

2. Select a query from the list of saved queries.

3. Click OK to load the query. The query is displayed in the Define
Query window.

4. Click Fetch to rerun the query.

� To delete a saved query:

1. Open the Load or Delete Query window.

2. Select the query from the list of saved queries.

3. Click the Delete button.
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Printing a Query

You can print a query by selecting the print button in the built–in ADE
spreadsheet window.

� To print a query:

1. Click the Print button from the Data Preview window.

2. Select the print options using the Print dialog displayed.

3. Click OK to print the query data.
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Saving an Application Spreadsheet

To save a spreadsheet you need to transfer your data to your PC, and
launch the application spreadsheet from ADE.

Note:  The spreadsheet is saved to a file called HRIO.
(Spreadsheet file extension).

� Saving the spreadsheet in application mode:

1. Double–click the ADE button on the applications toolbar.

2. Select a style from the ADE Fetch window.

3. Choose the Spreadsheet option from the ADE spreadsheet window.

4. Select Save in the spreadsheet application.

� Saving the spreadsheet in standalone mode:

1. Start and logon to ADE from the desktop.

2. Query some data.

3. Select the Spreadsheet option from the Data Preview window.

4. Select Save in the spreadsheet application.
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Exporting Data Using ADE in Application Mode

ADE exports data contained in an application window by:

• Re–executing the last query performed in your application then
transferring the records ADE

• Transferring the current record displayed in your application

Data is transferred to the built–in ADE spreadsheet and displayed in
the Data Preview window. You can then launch your word processor or
spreadsheet application to perform a mail merge or analyze the data.

Your System Administrator defines a style to specify what records are
transferred to ADE.

� To query and export data from an application window:

1. Query an application window to retrieve a group of records or a
single record.

You can use any of the techniques for entering or querying data in
Oracle HRMS or OTA to select records you want to export from
your database.

2. Click the Spreadsheet icon on the application toolbar to launch
ADE in application mode.

3. Select a style from list box displayed next to the window name in
the ADE Fetch Data window.

Note:  Styles are predefined by your System Administrator.

4. Select one of the following actions:

• None, to transfer data to the built–in ADE spreadsheet,
displayed in the Data Preview window. You can then launch
your spreadsheet application or word processor to process the
data.

• Word Processor, to launch your word processor to perform a
mail merge.

• Spreadsheet, to launch your spreadsheet application to analyze
or report on the data.

5. Click the Fetch button to transfer data to the Data Preview window.
Use the Back button in the Data Preview window to abandon the
transfer.

6. Select an Action radio button and click the Start button to transfer
data and launch the application.

Note:  When you launch your spreadsheet application or a
word processor, from the ADE Fetch Data window or the Data
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Preview window, the data is transferred to a temporary file
(HRIO.XLS). Save the file with a new name to prevent it being
overwritten the next time the application is launched.

In a mail merge, data from HRIO.XLS will be merged with the
standard Word document. The document is defined by your
System Administrator.
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Data Uploads

What Are Data Uploads?

You can extract data from Oracle HRMS or OTA then modify the data
with desktop spreadsheets, word processors or other applications. You
can then upload the data you have modified back to Oracle HRMS or
OTA.

What Can I Use Data Uploads For?

You can perform what–if calculations on your organizational data
without affecting the information that is held on your database. When
you are satisfied the modified information is correct, you can transfer it
to your database.

Does ADE Check That Valued Information is Not Being Overwritten on Upload?

Yes. Your System Administrator can define queries that will allow a
complete or partial upload of modified information. ADE also provides
error checking that enables you to correct and resubmit upload
requests.
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Data Uploads Overview

The Upload Process

You can only upload data from a query that has been defined for this
purpose by your System Administrator. The definition of an upload
query specifies which data items are uploaded when modified or not
uploaded if modified.

Note:  Before information can be uploaded, it must first be
downloaded to a spreadsheet. ADE only supports updates to
existing information, not inserts.

For example, the Phone’s query style enables you to upload changes to
Email address and phone number but will not enable you to upload
changes to First Name or Last Name.

In addition to the Phone’s query style, ADE is also supplied with the
Salary Administration query style. This style enables you to download
salary proposal details, change the details, and then upload the
changed details back to Oracle HRMS or OTA.
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Uploading Applications Data

To upload data you must first query some data in either standalone or
application mode.

Note:  The upload facility must be enabled for your
responsibility by the System Administrator.

� To begin an upload in standalone mode:

1. Click the upload icon on the desktop.

2. Log on by supplying your username and password and selecting a
responsibility. The Data Upload window will display.

Once the Data Upload window is displayed you can upload data. See:
Parameters for Standalone Mode: page 5 – 14

� To begin an upload in application mode:

� Click the Data Upload button. This will display the Data Upload
window.

Note:  If the data upload button is not available, Data Upload
is not enabled.

� To upload data:

1. Click the Load button.

2. Select the spreadsheet from the PC filing system. If you have not
renamed the spreadsheet or overwritten it with a further copy, then
it will be stored as HRIO.XLS. The spreadsheet is saved in the
default directory defined at installation (C:\TEMP).

3. Load the spreadsheet and, optionally, review any changes. Changes
are marked by the Status column displaying Updated or the cells are
highlighted green.

4. Select a date to determine when the upload of data will be applied.

5. Select one of the following DateTrack modes:

• DateTrack Correction

Use DateTrack Correction if you do not need to keep a record of
previous information. After uploading the changes, the original
values are overwritten and lost.

• DateTrack Update

Use DateTrack Update if you want to keep a record of
information.
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• DateTrack Insert/Update

Use DateTrack Insert/Update to update future dated
information.

6. Click the Upload button. ADE uploads each row in turn. If no
errors occur, successful completion will be reported and the
number of rows updated is reported.

Note:  An error message is displayed if an error occurs during
upload.
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Correcting Errors When Uploading Data

If an error occurs during upload an error message is displayed. You can
either abandon the upload by choosing the Back button or continue the
upload. If you continue the upload, you can either select a prompt on
every error or ignore all further errors.

To view row errors double–click the row.

Warning:  If you attempt to upload a record you have changed
and another user has changed while you were making your
change, you will cause the upload to fail.

Note:  You can only modify data within the ADE internal
spreadsheet prior to performing an upload: that is, when you
have read your spreadsheet changes back into ADE and you
need to make minor modifications before starting to upload.

Likely Causes of Errors

Errors will occur if you:

• Select the wrong DateTrack mode

• Update or insert/update where people have future–dated
changes and others do not

• Don’t set the Type to B (Boolean) in the rows that specify the
APIs for the style in the Style Columns page

� To correct upload errors:

You can change the DateTrack mode and then upload selected records
again. To do this:

1. Double–click on the row  you want to upload.

2. Enable the upload checkbox.
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Letter Generation

Can I Create Standard Letters with ADE?

You can easily generate all the standard letters and requests you need
in Oracle HRMS and OTA. ADE enables you to generate letters in three
ways:

• Letter request mode where you can generate standard letters for
recruitment and enrollment.

• Standalone mode where you can generate standard letters for
other areas of organizational activity. In standalone mode, your
letter will be based on a predefined style.

• Application mode where you can generate standard letters for
other areas of organizational activity. In application mode the
basis for the mail merge will be the last query you performed in
your application, or a pre–defined style.
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Letter Generation Overview

Standard Letters and Reports

ADE retrieves data, exports the data file and merges it with a standard
WP (word processor) document. The WP document includes merge
fields and the standard text for the letter.

Standard Letters for Recruitment and Enrollment

You use ADE to generate standard letters for recruitment or enrollment
in Oracle HRMS or OTA. You do this with a mail merge from the
Request Letter window.

You must define one or more letter types for each letter you want to
generate. Each letter type is associated with a status, for example an
assignment status or an enrollment status. The status is used to
automatically trigger generation of the letters.

In Oracle HRMS, the statuses are applicant assignment statuses and are
associated with standard recruitment letters or reports. A request for a
letter is automatically created when an applicant is given an associated
assignment status.

In OTA, the statuses are enrollment statuses and are associated with
standard enrollment letters or reports. A request for the letter is
automatically created when an enrollment is given an associated status.

Note:  You can also create new letter requests manually, by
adding names to the list of people you want to receive a letter.

Other Standard Letters and Reports

You can also use ADE to create other standard letters and simple mail
merge reports. In application mode ADE uses the last query performed
in the window or a pre–defined style, to retrieve data for the merge. In
standalone mode you select a query style created by your System
Administrator to retrieve data for the merge.

Once the data is retrieved from your database, you perform a mail
merge by opening Word from ADE.
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Creating Standard Letters

These steps describe how to create standard letters or simple reports
users can select in ADE in standalone or application mode. You can
also use ADE in letter request mode to create standard letters for
recruitment or enrollment. These tasks are performed by a System
Administrator and certain tasks may require assistance from a
Database Administrator.

Note:  ADE is not the only way to create standard letters and
reports using mail merge.

� To  generate standard letters:

1. Define a letter type for each standard letter you want to generate.
Each letter type associates a standard letter with one or more
assignment or enrollment statuses.

2. Define views to retrieve data for each standard letter in standalone
and letter request mode. A number of HRV views can be found in a
script delivered as part of a client–side install. Your Database
Administrator can customize this script to create any additional
views required.

Note:  You do not need to create a view in application mode.
The query uses the view of the current window or that of the
pre–defined style.

3. Create a style for each standard letter. A style defines the data
columns used to hold the data for the mail merge, and any other
parameters required to retrieve the data and perform the merge.

You should create the following styles:

• A GENERAL style if you are exporting data for the merge in
standalone mode

• A FORM style (where FORM is the name of the window) if you
exporting data for the merge from an application window,  in
application mode

• A LETTER style if you are exporting data for the merge in letter
request mode 

Note:  Remember to include the name of the Word document
you plan to set up for the merge, for each style you create.

4. Create a WP merge document.



4 – 5Letter Generation

Choosing a Mail Merge Document

When you submit a request using the Request Letter window, ADE
retrieves the data required for the mail merge. If more than one letter
style is defined for the letter type, you must select the document you
want to use for the mail merge, using the Letter Choice window.

� To choose a mail merge document:

1. Select the document from the list of mail merge documents:

2. Do one of the following:

• Choose OK to transfer the data and perform the merge.

• Choose Cancel if you want to cancel the data transfer.
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Setup of ADE

Do You Need a Separate Licence for ADE?

No. ADE is supplied with Oracle HRMS and OTA.

Are There Installation Options for ADE?

Yes. You will need to install ADE on your System Administrator’s PC
but can then choose to install ADE as a Non–networked installation for
individual PC users.

Does ADE Protect the Security of Data?

Yes, in the same way as Oracle HRMS and OTA, ADE uses a security
model that restricts access by responsibility and Business Group.

You can also use ADE styles to restrict access to data. An ADE style
specifies what data is retrieved in a query and can be associated with a
responsibility.
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Setup of ADE Overview

Once installed ADE must be set up for each PC you want to use. This is
typically a task for your System Administrator and Database
Administrator.

Types of Installation

ADE can be installed on a:

• System Administrator’s PC

• Non–networked installation for individual PC users

When you install ADE for an individual PC user, you must:

• Repeat the steps you completed for installation on the System
Administrator’s PC.

• Configure the installation for an individual PC user.

Security and Control

ADE uses the same security model as Oracle HRMS and OTA.
Responsibilities restrict access to data exported from the applications
database, and provide other features that enable you to control the
view of data retrieved by queries. Styles specify queries and can define
responsibilitys to restrict user access to a query. You can also use styles
to define how data retrieved by a query is used, for example, a mail
merge to generate a set of standard letters.

For  standalone mode styles you can specify whether exported data can
be edited and uploaded back to the database and so modify your
applications data.

Customizing iHelp

Oracle Applications Help has an improved help interface for Release
11i which makes it easier to patch, customize and search online help.
You can now display a customized set of help files configured by your
system administrator to reflect global, local and vertical variants of
HRMS. It is possible for your system administrator to specify that your
set of help files can include material stored in a document repository,
for example, policy documents, market survey information and so on.
This means that the help files that you see are directly related to the
work that you do.

See: Customizing Oracle Applications Help, Oracle Applications User’s
Guide.
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Styles for ADE Setup

ADE Style Definitions

A style defines the data retrieved by a query, the format of the data
exported and security. It also specifies any parameters required to
process the extracted data. Styles include some or all of the following
definitions:

• The responsibility that can use the style.

Each style can be  defined for a specific responsibility so that you
can only use it if you log on with that responsibility.

• The data retrieved.

Each query uses the view for the current application window or
a view on the server.

• The format of the exported data.

The data format specifies the style columns (corresponding to
database fields) for the spreadsheet holding the exported data.
The definition of each column includes the column width, the
data type and if the data can be updated.

• Whether the data can be uploaded back to the database.

If data can be modified, the API used to upload the data must be
included in the definition of the style.

Note:  Your System Administrator must include a function on
the menu for your responsibility, so you can use the style to
upload data.

• If exported data is used to perform a mail merge, the name of the
WP document used to merge the data.

You can generate standard letters and reports and use the merge
features of your word processor. Exported data can be merged
with a standard Word document to generate standard letters.

• If data is used to generate standard letters for recruitment or
enrollment using the Request Letter window, the name of the
letter. This specifies the letter, defined as the letter type, and the
recruitment/enrollment statuses used to trigger requests for the
letter.

You can also export data to a spreadsheet application for analysis and
graphical representation.

For some queries performed using ADE, you can edit and manipulate
the data over a period of time, and upload the modified data to your
database to modify your applications data.
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Style Types

Your can define the following style types:

• GENERAL – exports data directly from the applications
database using ADE in standalone mode. The data is retrieved
by a view on the server, using a SQL*Plus script, included in the
style.

• FORM  – exports a set of records or a single record from an
application window (where the name of the window is
specified), using ADE in application mode. The data is retrieved
by the view used by the application window.

• LETTER– exports data to a mail merge document and generate
standard letters for recruitment or enrollment, using ADE in
letter request mode. The data is retrieved by a view on the
server, using a SQL*Plus script, included in the style.

• UPLOAD – enables updates to information already downloaded
to ADE. The initial information can be downloaded in either
standalone or application mode.

Note:  You can only modify and upload information that was
initially exported from ADE. You cannot insert new
information.

Style Definitions

To create a style, you must specify the style type and the specific data
fields (or columns) for the spreadsheet holding the data retrieved by
the style, and the format for each data column.

Note:  If you are creating a FORM style, enter the name of the
application window.

Depending on the type of style and how the data is retrieved you can
define:

• The view(s) used to retrieve the data

• An API for uploading modified data

• A WP document for performing a mail merge

• A letter type to associate recruitment/enrollment statuses with a
specific standard recruitment/enrollment letter.

• An API for uploading modified data back to your database.
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Views for ADE Setup

Views

ADE has the following views:

• Query views

Used to export data from the database to a spreadsheet
application.

• Shadow views

Used with a style in application mode.

• List of value (LoV) views

Used in standalone queries to display a list of values.  LoV views
enable selection of a value from a list, that is restricted to a
limited set of values.

View(s) created for a standalone query are included in the style
defined for the query.

• HRV views

Used to retrieve data for each standard letter generated from the
Request Letter window.
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Outline of Setup Steps

Setup Steps

You must setup ADE individually for each PC you want to use.
However, to save time you can copy some of the settings and styles
and make them available to all PCs and ADE users. Typically, you
might start by setting up ADE on a master PC and selecting the options
you want to use as the defaults for other PCs. You can then save the
settings and use them as the master settings you can modify for
individual ADE users.

ADE is usually setup by your System Administrator. Setup Steps
include:

❑ Basic Setup

These steps include configuring the PC before installation,
installation, defining paths and miscellaneous options. You also
define menus in this step.

These steps include creating views, preparing API scripts and
creating styles.

❑ Application Mode Setup

These steps include creating styles.

❑ Letter Request Mode Setup

These steps include defining letter types, creating views and
styles and creating mail merge documents.

❑ Additional Setup

You will need to complete additional procedures to install ADE
on a network. And complete any procedures, listed below,
relevant to your installation.

– Install ADE on a Non–Networked PC

– Create a New Style

– Create Styles for Upload

– Define a Style Type

– Define a Style

– Define Style Columns

– Modify a Style

– Delete a Style
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– Set View Prefixes

– Specify Environment Variables

– Test ADE Settings

– Set the Display Mode for ADE Windows

– Display the Version Number

– Debug ADE
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Example: Query View

This view returns a list of employees’ last names, their employee
numbers and their gender:

create or replace view hrv_person as

select

  pp.business_group_id,

  pp.object_version_number,

  employee_number,

  last_name,

  sex,

  work_telephone

from

  per_assignments_v pa,

  per_people_secv pp

where

  pa.person_id = pp.person_id

/

The Business Group identifier is included in the view (with the name
BUSINESS_GROUP_ID), to automatically include a WHERE clause to
restrict the data returned by Business Group. The Business Group is
determined by the user login.

Include in the view any fields you are using to restrict the scope of the
search. These will be regarded as mandatory columns when the data is
viewed in your spreadsheet.

Additionally, Query views must comply with the following rules:

• The view name should begin HRV_. This prevents a user from
modifying their ADE options to read data from other tables or
views.

• The view should include the object version number, if it is used
to return data that can be modified and uploaded back to the
database using ADE.

The example view, is based on a secure view that gives the object
version number from the base table, as well as using
FND_SESSIONS for date effective queries.
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Example: Shadow View

This view enables a user  to find email and phone information for
people.

create or replace view HRV_PER_PEOPLE_V as

select

  PER.ROWID ROW_ID,

  PER.PERSON_ID,

  PER.LAST_NAME,

  PER.EMAIL_ADDRESS,

  PER.EMPLOYEE_NUMBER,

  PER.FIRST_NAME,

HR_GENERAL. GET_WORK_PHONE (PER_PERSON_ID)
WORK_TELEPHONE,

  PER.OBJECT_VERSION_NUMBER,

  PER.BUSINESS_GROUP_ID,

  PER.PERSON_TYPE_ID

from

  PER_PEOPLE_SECV PER

/
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Example: List of Values View

This view below enables a user  to select gender from a list of values.
The LoV view creates a list of values by building a WHERE clause:

create or replace view hrv_lov_gender as

select

  lookup_code internal_value,

  meaning display_value

from

  fnd_common_lookups

where

  lookup_type = ’SEX’

/

List of value views must comply with the following rules:

• The view name must begin HRV_LOV_.  (You don’t need to
enter the HRV_LOV prefix when you enter the name of the view
in the style).

• The view must include a column defined as INTERNAL_VALUE
that returns the internal value for an item.

• The view must include a column defined as DISPLAY_VALUE
that returns the value seen by the user.  In the example above,
”Male” is the display value where the internal value is ”M”.

• If a list of values must be restricted by Business Group, it must
include a column defined as BG_ID.

For example:

create or replace view hrv_lov_grade as

select

  grade_id internal_value,

  name display_value,

  business_group_id bg_id

from

  per_grades

/
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Example: Letter Request View

This view returns a person’s first and last name following a letter
request:

create or replace view hrv_people_letters as

select

  letter_request_id,

  last_name,

  first_name

from

  per_letter_request_lines plrl,

  per_people_f pp

where

  pp.person_id = plrl.person_id

/
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Reference Material for ADE Setup

Parameters Passed  to ADE

The parameters passed to ADE control how ADE is launched.

Parameters for Application Mode

When ADE is started from the HRMS Applications the toolbar, a file is
created by the Application. The file is called HRIO.TXT and is saved to
the C:\Temp directory of the computer running Forms 6.0. The file
records:

• The form name from where ADE was started

• The current date

• The session date

• A flag recording whether default queries are allowed for the user

• The SQL statement from the last query

• A list column definitions for the folder if the current form is a
folder

ADE is also passed the username, password and connect string of the
user’s responsibility.

The parameters are:

• gwyuid@tnsname fndnam username/password

Username and password are for the Oracle account ADE is
connected to and are the same as the application logon.

If this method is used to start ADE, from the desktop, then it runs as
though it is in Applications mode and reads the last known HRIO.TXT
file on the PC.

Parameters for Letter Request Mode

When ADE is started by selecting the ADE spreadsheet icon in the
Letter Request form, it is run and passed the following parameters on
the command line:

• The username, password and connect string for the Oracle
Account to which the Application is connected for the user’s
responsibility.

• The session date
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• The letter type name. This is a single record in the table
PER_LETTER_REQUESTS. This is because the user has
requested a set of one type of letter to be printed, as defined by a
row in PER_LETTER_TYPES.

• The letter request id. This identifies a number of records in
PER_LETTER_REQUEST_LINES, each record corresponds to a
single letter.

The parameters passed, when ADE is started from the Letter Request
form are in this format:

• gwyuid@tnsname fndnam username/password sd=<date>
ln=<letter> lri=<id>

Where:

• sd = (Session Date)

• ln = (Letter name)

• lri =(Letter Request ID)

Parameters for Standalone Mode

ADE can be started in standalone mode in a number of ways, with or
without parameters. If no parameters are set ADE runs in standalone
mode and details of the database are taken from ORACLE.INI and
OACONFIG.ORA.

If parameters are set they are set in the command line. The format is:

• USERID=gwyuid@tnsname FNDNAM=<name>

This is useful for defining a number of different icons for different
databases.

Note:  The user and password are for the AOL gateway
account, so there are no security issues with the user seeing
these details.

You can also set keywords at the end of the command line. The
keywords you can set in standalone mode are:

• OVERRIDE

This keyword enables a System Administrator to correct the
checksum in the ADE.INI file.

• UPLOAD

This keyword enables ADE to run uploads in standalone mode.
UPLOAD should only be enabled for users who have an Upload
responsibility. You should set up an Upload icon for these user’s.
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Parameters for the Diagrammers

The organization and position hierarchy diagrammers are separate
programs that can be started from ADE. Starting the diagrammers in
this way makes connection to the correct database easy and meets the
Oracle HRMS security model.

However, you can also run diagrammer’s from the desktop by using
this command:

• ORGHIER <user>/<password>@<tnsname> <bgid> <mode>.

The username and password is for the secure user account used by the
user, or the Apps account if HRMS secure users are not set up. BGID is
the ID of the Business Group, and MODE is 0 for read/write, or 1 for
read only.

The organization hierarchy diagrammer is called ORGHIER and the
position hierarchy diagrammer is called POSHIER

Parameters for Discoverer

ADE can connect to Discoverer in one of two ways, depending on the
version of Discoverer you have. You can connect to Discoverer with a
username and password, which means limited security. Or, in the latest
version of Discoverer, you can connect with a username, responsibility
and password. Connecting in this way ensures strict security and limits
a user’s access to data, by responsibility.

To use the enhanced security model you launch Discoverer in
Application mode. You do this by appending the text fragment
APPSMODE to the Discoverer path you set in the ADE Options Tab.

Note:  APPSMODE is only available in the latest version of
Discoverer.

You can still open old and new versions of Discoverer from ADE
without setting APPSMODE. You can do this by not appending the
mode to the Discoverer path.

Note:  Discoverer’s Reporting User’s are not supported in
ADE.

Supplied Styles

ADE is supplied with several styles that enable your System
Administrator to quickly set up a number of general standalone
queries, as well as queries for a number of specific windows within
Oracle HRMS and OTA. You can modify these styles, create your own,
or delete styles you do not require.
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Note:  To use the supplied styles you must run the
hradevws.sql script.

Supplied Views

You supplied views are located in the product directory:

• $PER_TOP/admin/sql

Supplied APIs

For a list of supplied APIs:

See: Publicly Callable Business Process APIs, Customizing,
Reporting, and System Administration in Oracle HRMS.

ADE File Formats

You may need to view the settings displayed in the ADE.INI file, the
Saved Query Files, and the Forms 6.0/ADE Communication File.

ADE.INI File

The ADE.INI file stores the settings for ADE. You can view the file
using a text editor such as Windows Notepad. The format of a typical
ADE.INI file is shown below.

Attention:  You should not make any changes to your
ADE.INI file without consulting your System Administrator.

Entry Description

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

[HRIO] ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines the start of the section containing envi-
ronment settings.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

TEMP=C:\TEMP\ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Location of the temporary directory.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

WP=C:\MSOFFICE\WINWORD\WIN-
WORD

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Location of the MS Word executable.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

SS=C:\MSOFFICE\EXCEL\EXCEL ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Location of the spreadsheet executable.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

LETTERS=C:\HRIO\LETTERS\ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Location of MS Word documents used for mail
merges.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

USER=H:\ORAWIN\BIN\PLUS31 ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Location of a user defined executable.
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DescriptionEntry

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

USER_WORKING=H:\ORAWIN\BIN ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Working directory for the user defined pro-
gram.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

DISCOVERER= ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Location of Discoverer executable.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

DISCOVERER_WORKING=H:\ORA-
WIN\BIN

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Working directory for Discoverer.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

QUERIES=C:\HRIO\QUERIES ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Directory used to save queries and results.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ORG= ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Location for the Organization Hierarchy Dia-
grammer.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

POS= ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Location for the Position Hierarchy Diagram-
mer.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

MAX_RECORDS= ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Maximum number of records that can be
downloaded to the Data Preview window.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

UPDATE_MODE= ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Defines whether the data upload facility is en-
abled (ON/OFF).

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

VENDOR= ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

This is either Lotus or Microsoft.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

FNDNAM= ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

AOL FNDNAM (for running without applica-
tions).

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

GWYUID= ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

AOL GWYUID (for running without applica-
tions).

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

HELP_URL= ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Defines the location of the ADE help files

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

[PERWSEPI]
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Defines the start of a section specifying styles
for the Person window – PERWSEPI.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

STYLE=Summary of people,,,S
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Defines a style that returns a single record
when ADE is used in application mode from
the Person window.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

FIELD=LAST_NAME,Surname,2,1 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Defines the first field for the spreadsheet.  The
column in the view is LAST_NAME, shown on
the spreadsheet with ‘Surname’ as the column
header and a width of 2 inches.  The trailing 1
is not currently used.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

[GENERAL] ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Defines the start of a section that contains
styles for use by ADE in standalone mode.
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DescriptionEntry

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

STYLE=People,,HRIO_PERSON,M,,MAN-
AGER

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines a style for queries using the
HRIO_PERSON view, which returns multiple
records for the MANAGER responsibility.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

FIELD=EMPLOYEE_NUMBER,
Employee number,2,1,V,HRIO_TEST

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

The first field in the style.  The column in the
view is EMPLOYEE_NUMBER, shown in the
spreadsheet with ‘Employee number’ as the
column header that is 2 inches wide.  It is a
VARCHAR meaning there is no list of values
available.  The last parameter is the name of an
API for uploading data.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

FIELD=SEX,Gender,1,1,
HRIO_LOV_GENDER

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Indicates there is a list of values for the field
that is returned by the view HRIO_LOV_GEN-
DER.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

FIELD=START_DATE,
Hire date,1,1,D

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Indicates the column is in date format.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

[LETTER] ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Indicates the start of a section that define styles
used for mail merges within the Request Letter
window.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

STYLE=Simple Letter, PEOPLE,
HRIO_PEOPLE_LETTERS,M,APPLETTERÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines a style called ‘Simple Letter’, which
reads records from the view
HRIO_PEOPLE_LETTERS and performs a mail
merge with the Word document PEOPLE.  The
letter type for the style is APPLETTER.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

FIELD=FIRST_NAME,
First Name,2,1,V ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines a field in the style.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

[CHECKSUM] ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines the checksum for the file, used to pre-
vent unauthorized changes.

Saved Query Files

When the Data Preview window is displayed showing the data
transferred for a query, the query definition is saved in a file called
HRIO.QRY in the Temporary directory. If the query is saved,
HRIO.QRY is copied to a file in the Queries directory and saved with a
filename NNNNNNNN.QRY, where N represents a number taken from
the date and time stamp for the file.

The format of a sample saved query file is shown below.
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Entry Description

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

[User defined query] ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Identifies the file as a user defined query.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Description=Recent joiners to depart-
ments 071/072

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

The description given to the saved query.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Style=People ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

The style used for the query.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Session date=06/01/96 ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

The effective session date for the query.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

[Select details] ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines the start of a section that defines the selec-
tion details (or conditions) for the query.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Gender=Female ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Specifies a query condition in the selection details
section.  The a character is a special separator that
appears as a space in the built–in ADE spread-
sheet.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

[Query] ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines the start of a section specifying the exact
SQL statement for the query.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

[Column details] ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines the start of a section specifying the details
of each spreadsheet column used to hold the re-
trieved data.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

FIELD=EMPLOYEE_NUMBER, Employee
number,

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Specifies that the data returned from the view col-
umn EMPLOYEE_NUMBER is returned in a
spreadsheet column with the title ‘Employee num-
ber’ that is 2 inches wide.

Forms 6.0/ADE Communication File

When ADE is launched in application mode from the toolbar within an
application, it writes information to a file called HRIO.TXT in the
C:\Temp directory of the machine on which Forms 6.0 is running.

The format of a sample HRIO.TXT file is shown below.

Entry Description

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Form ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Specifies the name of the application window
used to launch ADE.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

System date. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The system date for the PC used to launch
ADE.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Session date ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The effective session date when ADE was
launched.
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ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

User ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

The name of the AOL user when the user
logged in to the application.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Responsibility ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

The line after this is the name of the AOL re-
sponsibility used by the user to log in to the
application.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Query
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

The full SQL statement for the last query issued
by the window before launching ADE.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Default query
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Displayed as ‘Disabled’ or ‘Enabled’ depend-
ing on whether the user can perform default
queries in ADE.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

ROW_ID ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

The line after this contains the row id of the
current record displayed when ADE was
launched.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Folder ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Specifies whether the window used to launch
ADE is a folder window.  If the window is a
non–folder window this entry is excluded.  The
information after this entry defines the col-
umns displayed in the folder window.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Column=FULL_NAME,
Full Name,1.918 ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Defines one folder column that includes the
column name taken from the view, the prompt
for the column and the column width in inches.

Use of Functions and AOL Function Security

AOL enables you to define:

• Users

• Responsibilities

• Menus

• Functions

Oracle HRMS system is supplied with sample menus and
responsibilities. The System Administrator must setup user’s and
define their responsibilities.

In addition, AOL provides the ability to define functions, and place
these functions on menus, in addition to any forms defined on those
menus. If a user selects a responsibility which uses a menu that has
these functions on them, then the user is said to have been granted
these functions.
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A number of functions are used by ADE; when ADE is launched, either
standalone or within the Application, it checks the responsibility in use
by the user to locate the menu in use, and thus establish what functions
are granted. In Prod–16 and after, these functions are seeded, but the
System Administrator must still place them on menus, if required.
Prior to Prod–16, the functions were not seeded, but the AOL Define
Function form can be used to create them.

Defining Functions

Each function has a user name and an internal name. ADE looks for the
internal name when checking if a function is granted to a user, and a
full list is given later.

The choice of display name is determined by the name allocated by the
System Administrator when the function is created, although where
Oracle have seeded the functions at Prod–16, the user names name the
format of ’ADE: <description>’.

List of Functions

Function Purpose

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

HR_HRIO_ORG_READ ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Provide read access to Organization Diagram-
mers

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

HR_HRIO_ORG_UPDATE ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Provide update access to Organization Dia-
grammers

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

HR_HRIO_POS_READ ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Provide read access to Position Diagrammers

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

HR_HRIO_POS_UPDATE ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Provide update access to Position Diagram-
mers

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

HR_HRIO_ENABLE_OPTIONS ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Enables a user System Administration access to
the ADE options, without having such access
to the AOL GUI forms. When the user chooses
a responsibility to which this function is
granted, the ADE Options window is invoked.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

HR_HRIO_DEFAULT_QUERY
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Enables the user to perform a default query
operation in Application mode, i.e. fetch all
columns obtained in the query performed by
the form.
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Enables the user to perform upload operations.
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PurposeFunction
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Enables the user to automatically create a style
from the query
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Enables the user to generate a view file from
the query performed in Applications mode.
Typically only granted to System Administra-
tors.
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Reference Material for ADE Installation

What Happens During the Installation of ADE

Once you have chosen the desired component InstallShield will carry
out a number of steps. The steps are:

• Pre–installation

• Installation

• Post–installation

Pre–Install

During pre–install InstallShield will find the applications associated
with the files extensions .doc (documents), .xls (spreadsheets), and .dis
(Discoverer). These will be used to set the appropriate Paths in your
ADE initialization file.

The following directories will be created beneath your Destination
folder:

• \Letters – for letters used with ADE

• \Oracle – for Oracle files required for ADE

• \SQL – for SQL files used by ADE. This folder contains the
script that should be run if you want to use seeded ADE styles

• \Queries – for query files generated by ADE

• \Backups – for any backed up ADE.ini file

• \Help – for help files used by ADE

Install

The install process will move copy all the required files to the
appropriate directories on your PC.

Post–Install

The post install process will:

• Update the ADE.ini paths copied onto your PC

• Backup any existing ADE.ini file to the Backups directory

• Copy the modified ADE.ini onto your PC

• Add an ADE shortcut to your Start>Program Menu

• Register Oracle Objects file (oraipsrv.reg)
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• Register ADE’s spreadsheet tool (vcf15.ocx)

• Register ADE’s language library (aderes.dll)

• Add a destination folder to the Path environment setting for NT

• Modify the autoexec.bat to include the ADE directory in the Path
setting for Windows 95 or 98

Once the post–install process is complete you should reboot you PC to
enable the changes.

See: Publicly Callable Business Process APIs, Customizing,
Reporting, and System Administration in Oracle HRMS.



5 – 25Setup of ADE

ADE Setup
Once ADE is installed, it must be configured for each PC  so that users
can retrieve and export the information they require. The System
Administrator must define the paths to your word processor or
spreadsheet application, define the required styles, and define any
letter types and mail merge documents.

Setup Steps: Basic Setup

• Step 1: Perform Pre–requisites Prior to ADE Install: page 5 – 27

• Step 2: Run InstallShield: page 5 – 28

• Step 3: Define Paths: page 5 – 29

• Step 4: Set Miscellaneous Options: page 5 – 31

• Step 5: Define Menus: page 5 – 32

• Step 6: Create Views for Standalone Queries: page 5 – 34

• Step 7: Prepare Scripts for APIs: page 5 – 35

• Step 8: Create Styles for Standalone Queries: page 5 – 36

Setup Steps: Application Mode Setup

• Step 9: Create Styles for Application Queries: page 5 – 37

Setup Steps: Letter Request Mode Setup

• Step 10: Define Letter Types: page 5 – 38

• Step 11: Create Views for Letter Requests: page 5 – 39

• Step 12: Create Styles for Letter Requests: page 5 – 40

• Step 13: Create Mail Merge Documents (All Standard Letters):
page 5 – 41

Setup Steps: Additional Setup

Note:  You will need to complete additional procedures to
install ADE on a network drive. And complete any procedures,
listed below, relevant to your installation.

• Install ADE on a Non–Networked PC: page 5 – 43

• Create a New Style: page 5 – 44

• Create Styles for Upload: page 5 – 47

• Share Styles: page 5 – 46

• Define a Style Type: page 5 – 49

• Define Style Columns: page 5 – 50
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• Modify a Style: page 5 – 52

• Delete a Style: page 5 – 53

• Set View Prefixes: page 5 – 54

• Specify Environment Variables : page 5 – 55

• Test ADE Settings: page 5 – 57

• Set the Display Mode for ADE Windows: page 5 – 58

• Debug ADE: page 5 – 59

• Display the Version Number: page 5 – 60
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Step 1: Performing Pre–requisites Prior to ADE Install

You must install 32–bit SQL*Net, included in your setup files, before
you install ADE.

Once 32–bit SQL*Net is installed, configure the 32–bit TNSNAMES file
to connect to your database. Check you can connect with 32–bit
SQL*Plus.

Note:  In some versions of 32–bit SQL*Net only allow editing
of the TNSNAMES through the SQL*Net Easy Configuration
tool.

If you intend to use Organization and Position diagrammers, you must
also install 16–bit SQL*Net. However, this means you must maintain
two TNSNAMES.ora files. A 16– bit .ora file, in your ORAWIN code
tree, and a 32–bit .ora file, in your ORANT or ORAWIN95 code tree.

Note:  As part of an 11i upgrade all existing HRV views are
removed. This includes any Views you have created. We
recommend you save any Views you have found useful.
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Step 2: Running InstallShield

InstallShield enables you to install and register ADE.

� To run InstallShield:

1. Close all programs.

2. Locate the directory that contains the ADE Setup program.

3. Double–click the Setup.exe file.

This will start the InstallShield program and display a number of
screens. The screens include a:

• Welcome screen

• Choose Destination Location screen

Note:  By default ADE is installed in C:\Program Files\ADE.

• Select Components screen

This screen enables you to select the correct environment. For
example:

– ADE for Release 10sc

– ADE for Release 10.7NCA

– ADE for Release 11

– ADE for Release 11i

4. Following the Select Components screen, InstallShield will copy
files to your PC.

See: Reference Material for ADE Installation: page 5 – 23 for further
information about the Install program.
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Step 3: Defining Paths

On initial setup a System Administrator must log on to ADE, using the
SYSADMIN username and password, and define application paths.
This is done with the Options button on the ADE Signon window.

You should set these paths for each PC you want to run ADE.

You can define paths for the following applications:

• A word processor

• A spreadsheet

• An HR Organization Diagrammer

• An HR Position Diagrammer

• Discoverer

• A user defined program, for example, a SQL*Plus pages script,
and the working directory for the program.

Suggestion:  To identify the paths for a program on the
Windows desktop, select the icon and choose the Properties
option then select the shortcut tab.

� To define paths:

1. Start ADE in standalone mode.

2. Click the Options button to open the Paths Tab in the Option
Window.

3. Define paths for any applications or programs used with or
launched from ADE. Specify the drive in every field.

Note:  Executable files are assumed to have the .exe extension.
You do not need to enter this explicitly.

Note:  To launch Discoverer in Application mode you need to
append this text fragment, APPSMODE, to the path.
Application mode is only available in the latest version of
Discoverer and is used to enable stricter security.

4. Accept the defaults or define paths, found in the Directories region,
for the following ADE working directories, a:

• Temporary directory for storing temporary files such as
spreadsheet files. The default is C:\TEMP.

• Query directory for storing saved query definitions. The default
is C:\Program Files\ADE\QUERIES.

• Letters directory for storing WP documents set up for mail
merges. The default is C:\Program Files\ADE\LETTERS.
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Note:  The default location for queries and letters assumes that
ADE is installed in the C:\Program Files\ADE directory. If
ADE is installed in any other directory, then the letter and
query directories will be subdirectories of that location. For
example, if ADE were installed in D:\HRPROGRAMS\ADE
then the letters directory will be found in
D:\HRPROGRAMS\ADE\LETTERS.

5. Select the Save or Undo buttons to save or undo your changes.

6. Select the Back button to save your changes to the ADE settings
file.

7. Select the Test button to run the program and check the ADE
settings.

See Testing ADE Settings: page 5 – 57

All saved changes are used as the default settings for ADE.
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Step 4: Set Miscellaneous Options

Miscellaneous options enable you select, the number of rows that can
be downloaded, AOL parameters, the Help URL and the name of your
database.

You should set these options for each PC you want to use to run ADE.

Note:  If you are installing ADE on a PC running Oracle HRMS
Release 10.7, then the AOL Gateway/Foundation details are
taken from the names defined for the applications in
OACONFIG.ORA, and you do not need to define them
separately.

However, you will need to define the AOL
Gateway/Foundation details if you do not have Oracle HRMS
installed on your PC or you are using Release 11i of Oracle
HRMS.

See: Reference Material for ADE Setup: page 5 – 13

� To Set Miscellaneous Options:

1. Start ADE in standalone mode with a System Administrator
Responsibility.

2. Select the Misc. Tab from the Options Window.

3. Modify the option settings and specify the:

• Maximum number of records that can be downloaded to a
spreadsheet. The default is 2000 rows.

• AOL Gateway name details.

• AOL Foundation name details.

• Help Base URL

• Name of the database

4. Select the vendor for the word processor and spreadsheet used
with ADE (Microsoft or Lotus).

5. Use the Save and Undo buttons to save or undo your changes.

6. Choose the Back button to save your changes to the ADE settings
file.

7. Use the Test button to run the program and check the ADE
settings.

See: Testing ADE Settings: page 5 – 57

All saved changes are used as the default settings for ADE.



5 – 32 Using Application Data Exchange and Hierarchy Diagrammers

Step 5: Defining Menus

Access to ADE in standalone and letter request mode are subject to the
security profile used by Oracle HRMS and OTA. They are also subject
to any responsibility attached to a query style.

You must add ADE functions to a menu for a specified responsibility.
This will enable users to access to ADE. Use the Menus window to do
this.

See: Menus Windows, Oracle Applications User’s Guide

See: Defining Menus, Customizing, Reporting, and System Administration
in Oracle HRMS.

See: Reference Material for ADE Setup : page 5 – 13

The ADE seeded functions follow.

Seeded Function Description
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HRIO Enable Options ÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Enables users to access all the ADE options,
without having to log in using the SYSADMIN
responsibility. By default, users can only access
the Paths page on the Options screen.
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HRIO View Organization ÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Enables users to launch the Organization Hier-
archy Diagrammer but prevent them from
creating or modifying hierarchies.
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Enables a user to launch the Organization Hier-
archy Diagrammer and edit organization hier-
archies.
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HRIO View Position
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Enables a user to launch the Position Hierarchy
Diagrammer to display position hierarchies but
prevent them from creating or modifying hier-
archies.
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Enables a user to launch the Position Hierarchy
Diagrammer and edit position hierarchies.
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Enables a user to select the Upload button on
the Fetch Data window (using ADE in applica-
tion mode) and upload modified applications
data exported from ADE in the same session.
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Enables a user to use the data in the Data Pre-
view window (running ADE in application
mode) to create a new style. A button appears
in the window for creating the style.
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DescriptionSeeded Function
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Enables a user to use data in the Data Preview
window (running ADE in application mode) to
create a new view. A button appears in the
window that requests ADE create a SQL file
that contains a view using the SQL issued by
the form. This can be used with an existing
style to create a view that can be used by ADE
in standalone mode or by a data query tool.
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HRIO Default Queries
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Enables a user to transfer data based on the last
query performed on an application window.
You can also transfer data from a folder win-
dow using the current folder definition view.
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Step 6: Creating Views for Standalone Queries

Views installed on the server are used to retrieve data for standalone
queries. A number of HRV views can be found in a script. The  script is
called hradevws.sql and is saved in the product directory
$PER_TOP/admin/sql. Your Database Administrator can customize
this script to create additional views, which must be installed on the
server.

See: Views for ADE setup: page 5 – 6

See: Reference Material for ADE Setup : page 5 – 13
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Step 7: Prepare Scripts for APIs

If the style created for a standalone query enables exported data to be
modified and uploaded back to the database, your Database
Administrator must write SQL*Plus scripts to allow APIs to be used.

You also need to define the specific fields that can be updated when
you define the data columns for the style.

Use the APIs provided to enable modified applications data to be
uploaded back to your database. The API name must be included in the
style used to retrieve the data from your database.

APIs included in the definition of a style must have a minimum of
three standard parameters:

• Object version number

ADE passes back the version number for each column. This must
match the version number created for each row transferred by
the original query. If the version numbers don’t match, the row
cannot be updated.

• Effective date

This is used by DateTrack to correct or update date effective
information.

• DateTrack mode

This is set by ADE to CORRECTION, UPDATE.

You can specify additional parameters as well, for example, the
PERSON_ID.

See: Reference Material for ADE Setup : page 5 – 13
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Step 8: Create Styles for Standalone Queries

A style for a standalone query must be defined as  GENERAL and
include the name of the view created on the server to retrieve the data.

You can now complete the standard style procedures. See: Defining a
Style Type: page 5 – 49
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Step 9: Creating Styles for Application Queries

Styles defined for queries using ADE in application mode must include
the name of the window used to return data for the query.

Note:  You do not need to define a view to retrieve data for the
query; the last query performed on the window is used to
retrieve the data. If a view is defined however the data will be
queried from this view.

See: Defining and Sharing Styles: page 5 – 46

See: Reference Material for ADE Setup : page 5 – 13
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Step 10: Defining Letter Types

If you want to generate automatic requests for recruitment or
enrollment letters you must define a letter type. Each letter type
associates a standard letter with one or more assignment or enrollment
statuses in Oracle HRMS or OTA.

The letters are generated with a mail merge from the Request Letter
window.

Note:  There are other methods for generating standard letters
and reports using a mail merge. To decide which method you
want to use to generate standard letters.

See: Letter Generation, Customizing, Reporting and System Administration
in Oracle HRMS

� To define a standard letter type:

1. Enter a name for the letter and select a concurrent program.

Note:  ADE does not use the concurrent program to retrieve
data for the mail merge; it uses the view created to specifically
retrieve data for the merge. However, it is a required field and
you must select a concurrent program (you can can select any
one).

See: Creating Views for Letter Requests: page 5 – 39

2. Select one or more assignment statuses and enable them.

When an applicant is given an assignment status, a pending request
for this letter type is created. If a pending letter request already
exists, the applicant is added to the list of people and is sent a letter
when you submit the request.

3. Select one or more enrollment statuses and enable them.

When a student is given an enrollment status, a pending request for
this letter type is created automatically. If a pending letter request
already exists, the enrollment is added to the list of people and is
sent a letter when you submit the request.

4. Save your letter type.
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Step 11: Creating Views for Letter Requests

Views installed on the server are used to retrieve data for each
standard letter generated using the Request Letter window. Sample
HRV views can be found in the hradevws.sql script. The view for each
standard letter type is included in the style defined for the letter
request. The letters are generated using the mail merge features of
Word. Requests for letters can be created automatically using the
applicant/enrollment statuses in Oracle HRMS or OTA.

To generate letters you must create a view that includes a column
defined as LETTER_REQUEST_ID from the
PER_LETTER_REQUEST_LINES table. The per_letter_request_lines
view must have one or more columns in the  table with other tables and
views in the database. For example, you might use PERSON_ID. The
view must also retrieve data for each merge field defined for the
standard letter.

See: Reference Material for ADE Setup : page 5 – 13



5 – 40 Using Application Data Exchange and Hierarchy Diagrammers

Step 12: Creating Styles for Letter Requests

A style used to generate letters from the Request Letter window must
be defined as a LETTER style. See: Style Types: page 5 – 5:

A letter request style must also include the name of the:

• View created to retrieve the data

• Letter defined as the Letter Type

• Document ADE will use to perform the mail merge.

The other parameters you must define are standard for creating any
type of style See: Defining and Sharing Styles: page 5 – 46.

See: Reference Material for ADE Setup : page 5 – 13
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Step 13: Creating a Mail Merge Document (All Standard Letters)

You use the mail merge facilities of Word, to merge data exported from
by ADE from your database, to generate standard letters.

Note:  Oracle HRMS and OTA provide other methods to
generate standard letters and reports. To decide which method
to use

See: Letter Generation: Customizing, Reporting, and System
Administration in Oracle HRMS.

� Prerequisites for generating letters:

To generate letters using ADE in letter request mode, you must:

• Define a letter type for the letter request.

• Define a view to retrieve data for the merge.

• Create a LETTER style for the letter. You must include the name
of the Word document you plan to set up for the merge.

See: Creating Standard Letters: page 4 – 4

To generate standard letters using ADE in standalone mode, you must:

• Define a view to retrieve data for the merge.

• Create a GENERAL style for the letter. You must include the
name of the Word document you intend to set up for the merge.

See: Standard Letters and Reports: page 4 – 3

To generate standard letters using ADE in application mode, you must:

• Create a FORM style for the letter, where you name the
application window used to retrieve data for the query.  You
must include the name of the Word document you plan to set up
for the merge.

See: Standard Letters and Reports: page 4 – 3

� To create a standard Word mail merge document:

1. Start ADE in standalone mode and log in as the System
Administrator.

2. Choose the Test button on the Paths page to display the Select Style
window.

3. Select the style to be used to export data for the mail merge.

4. Choose OK to confirm and start Word. Word opens a document
called HRIO.RTF that contains all the mail merge fields that match
the style.
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5. Enter the text for the letter and rearrange the merge fields in the
document.

6. Save the finished mail merge document as a Word document (with
a .DOC extension) to the Letters directory. This is the directory
defined for holding mail merge documents in the ADE Options.

Suggestion:  If you cannot locate the letters directory, launch
ADE in standalone mode from your PC desktop and choose the
Options button to check the path.
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Installing ADE on a Non–Networked PC

If there are no shared network drives, the procedure for installing ADE
on a user’s PC is the same as that for installing and configuring the
System Administrator PC.

After installation, copy the following files from the System
Administrator’s PC to the user’s PC:

• ADE.INI

Note:  You may need to change ADE.INI using the ADE
options window if the user has the spreadsheet or word
processor in a different location than that specified on the
Systems Administration PC.

• Any Word documents required for mail merges

You may also need to create icons for starting ADE in standalone mode
when working with special databases such as a test database or a live
database.

Users who have a responsibility that enables them to upload data
should set up an Upload icon on their desktop.

See: Parameters for Standalone Mode: page 5 – 14



5 – 44 Using Application Data Exchange and Hierarchy Diagrammers

Creating a New Style

To create a new style you must use ADE in standalone mode and use
the SYSADMIN responsibility and password.

� To create a new style:

1. Select the Styles page from the Options window in ADE standalone
mode.

2. Select the Create Style button to display the Enter Style and Form
window. Enter a name for the style and the type of style you want
to create in the Form name field.

See: Defining a Style Type: page 5 – 49

Note:  If you are creating a FORM style, you must enter the
form name for the application window (as an 8 character code).
To find the form name select the About Oracle Applications
option from the Help menu in the appropriate form.

3. Select a responsibility for the style in the Responsibility field. Only
ADE users who log on with that style can use it. If you don’t select
a responsibility, the style can be used by all ADE users.

4. In the View field define:

• A GENERAL or LETTER style, and enter the name of a view
created on your server that ADE uses to retrieve records from
the database.

• A FORM style, you can leave this field blank. When ADE is
launched in application mode from an application window, it
uses the view defined for the form to retrieve data.

Note:  A number of views are supplied in the VIEWS115.SQL
script. To use these views, run the script.

5. Enter the name of the letter in the Letter field if you are creating a
style for a letter request. This is the Letter Type you have defined in
Oracle HRMS or OTA.

6. Enter the name of the document ADE uses for the merge if the style
retrieves data for a mail merge to generate letters.

ADE assumes the document is located in the Letters directory
defined using the ADE Options.

7. If the data exported for a query can be edited and uploaded back to
the database, enter the name of the API that will be used to upload
the modified data in the Upload API field.

Note:  You must use a supplied API to upload data to your
database.
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For the current list of APIs in Release 11i see: Publicly Callable
Business Process APIs, Customizing, Reporting and System
Administration in Oracle HRMS

8. Check the Multiple Rows box if you want multiple records to be
returned by a FORM style.

The style uses the last query from an application window and
retrieves all records returned by the query.  If you don’t check this
option for a FORM style, data for the current record only is
returned.

9. Click Save Changes button to save the style. You can use the Undo
Changes button to cancel or undo changes.

10. Choose the Back button to save your changes to the ADE settings
file. If you don’t want to define the data columns to complete the
style definition you can save the settings and complete it later.

11. To define the data columns for the spreadsheet that holds the data
returned by the query, choose the Style Columns page in the
Options window.
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Sharing Styles

� To share styles:

� Place the ADE.INI on the network so that each PC can access the
style and then set environment variables in the AUTOEXEC.BAT of
each PC.  For example, SET HRIO_ADEDIR=D:\ADE.
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Creating Styles for Upload

Uploads can be enabled in application or standalone mode. In
Applications mode, you define a view to shadow the view used by the
applications form. In Standalone mode, there may already be a suitable
HRV view in the system, however it is likely you will need to define
one.

The columns the view returns are determined by the API used for
upload.

For the current list of APIs in Release 11i see: Publicly Callable Business
Process APIs, Customizing, Reporting and System Administration in Oracle
HRMS

You must return the following columns:

• A column corresponding to each mandatory parameter to the
API. The view column must have the same name as the API
parameter, excluding the ’p_’ in the API parameter name.

• A column OBJECT_VERSION_NUMBER which is taken from
the column of the same name of the base table on which the view
is based.

• Any number of columns corresponding to optional parameters
of the API, again excluding the ’p_’.  These additional columns
may be provided for information purposes, or so the user can
change the values.

Use the Style Columns page to enter the following numbers in the
Upd? column. By entering a number you can control whether a field
can be updated.

Number Description

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

0 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The column is a ’Display Only’ column, which
means that it is provided to the user in the
spreadsheet for information purposes only. It is
displayed with a grey background in the
spreadsheet. These columns can include man-
datory parameters for the API (excluding the
’p_’) where it is acceptable for the user to see
the information

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

1 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The column is an Updateable column, which
means it corresponds to an API parameter, is
displayed with a white background in the
spreadsheet, and the user may change it.
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DescriptionNumber

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

2 ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

API output parameters. These columns must
correspond to API parameters of type OUT.
They are not displayed in the spreadsheet, and
they MUST be stated last in the list of all col-
umns for the style. As they do not need to be
seen by the user, their display width should be
set to 0.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

3 ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

The column corresponds to a mandatory pa-
rameter in the API where the user should not
see the information.  As they do not need to be
seen by the user, their display width should be
set to 0.  There will always be an OBJECT_VER-
SION_NUMBER column in this category.

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

4 ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

This type is used for special DateTrack col-
umns, and two such columns must be provided
in the API supports datetrack operations.  They
are EFFECTIVE_DATE and DATETRACK_UP-
DATE_MODE. Values are substituted automat-
ically in these columns when uploading occurs.

In the Style Columns page specify the B Boolean API to use with the
style. See: Defining Style Columns: page 5 – 50

The Phones style is provided as an example, and this style is used in
the Person form, in conjunction with the HRV_PER_PEOPLE_V view
delivered in the hradevws.sql script.

The ability to upload data is controlled by AOL function security.

See Use of Functions and AOL Function Security: page 5 – 20

Whenever ADE attempts to upload data to the database, and trace
mode is on, a file called HRIO.API is created in the ADE temporary
directory. Trace mode shows where the call to the API was generated
and run.
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Defining a Style Type

Use the Enter Style and Form window to create a new style. You must
enter a name for the style and define the style type.

ADE uses different types of styles, see: Style Types: page 5 – 5

� To define a style type:

1. Click the Create Style button in the Styles page. The Enter Style and
Form window is displayed.

2. Enter a name for the style.

3. In the Form name field define a:

• Form style by entering the name of the form

Note:  You must enter the form name for the application
window (as an 8 character code). Select the About Oracle
Applications option from the Help menu to obtain the name of
the form.

• Standalone style by entering GENERAL

• Letter style by entering LETTER

4. Click OK to return to the Styles page in the Options window. This
will complete the style definition.
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Defining Style Columns

The columns defined for a style, specify which column in the
spreadsheet holds the data returned by the query. Each column
represents a field for the view that retrieves data for the query.

You can display all the columns for the data fields returned by the view
and then modify them to define the columns for a style. You must also
specify the format for each column to define the type of data it holds
and the width, and whether the data can be updated.

You must log on using the SYSADMIN username and password to
access the ADE Options window in standalone mode.

Prerequisite

Create the style using the Styles page in the Options window.

See: Creating a New Style: page 5 – 44

� To define columns for a style:

1. Select the Style Columns page, using ADE in standalone mode,
from the Options window.

2. Select the style in the Style field.

3. Select the Default button to display all the columns returned by the
view for the style. The format for each field is defaulted from the
field type. You can edit or delete the columns to create new column
definitions for the style.

4. Enter the name of the field title for the column in the spreadsheet.

If the data is used to for a mail merge, it is also used as the name
of the merge field. The field name can include alphanumeric
characters and spaces.

5. Enter the name of the column.

The column must either be one of the:

• Columns for the view created for the style (for a GENERAL or
LETTER style).

• Columns for the view used by the application window (for a
FORM style).

Suggestion:  If you don’t know the column names for a
specific application window, you can launch ADE in
application mode and perform a default query to obtain the
column names.

6. Enter the width of the column (expressed as a decimal number in
inches) to hold the data returned by the query.
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If the column is for a GENERAL style, you can enter a number to
specify if a field can be updated. The numbers are:

• 0

The field is displayed but cannot be updated in the spreadsheet

• 1

The field is displayed and can be updated in the spreadsheet

• 2

The field is not displayed

Note:  You can only modify applications data and upload it
back to the database using a style defined for upload. ADE
must also be running in standalone mode. See: Creating Styles
for Upload: page 5 – 47

7. Enter the field type for the column. You can define a field type as:

• V  (Varchar)

• N  (Numeric)

• D  (Date)

You can also define the name of the view that returns a list of
values. For example, you could create a view,
HRV_LOV_GENDER, to enable selection from a defined list of
values for gender (Male, Female, Unknown).

Note:  You must define a style column for each column that is
returned to a spreadsheet when the style is used.

8. Double click in a cell to display the full cell contents in the Edit Cell
window to modify a column or edit the entries for the column.

9. Highlight the row that defines the style column and choose the
Paste button to insert a new style column.

10. Highlight the row that defines the style column and choose the Cut
button to delete a style column.

11. Click the Save button to save the style. Use the Undo button to
cancel any changes.

12. Choose the Back button to save the style definition.
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Modifying a Style

You can modify an existing style and create a new style. You can also
edit the data columns defined for a style.

� To modify a style:

1. Select the Styles page,using ADE in standalone mode, from the
Options window.

2. Select the style from the list of styles.

3. Change any of the definitions for the style. For example, you can
change the view, document or letter name or responsibility
assigned to a style.

4. Click the Save button to save the new definition.

� To modify a style column:

1. Select the Styles Columns page,using ADE in standalone mode,
from the Options window.

2. Edit the entries for the column.

3. Double click a cell to display the full cell contents in the Edit Cell
window.

4. Click the Save button to save the new definition.
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Deleting a Style

Your System Administrator can delete an existing style using the Styles
page in the Options window.

You must log on using the SYSADMIN username and password to
access the Styles page.

� To delete a style:

� Using ADE in standalone mode, navigate to the Styles page in the
Options window, select the style from the list of styles and choose
the Delete Style button.

You are prompted to use the Save button to confirm the action, or
the Undo button to cancel.
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Setting View Prefixes

To enable you to control which views are displayed in the Styles page
you can set the prefixes of the views you need in ADE.

You must log on as a System Administrator to access the ADE Options
window.

� To add new view prefixes:

1. Select the Views page, using ADE in standalone mode, from the
Options window.

2. Enter the view prefix.

3. Click the Add Prefix button. The prefix is now displayed in the list
of view prefixes.

4. Click the Save button to save the changes. Use the Undo button to
cancel any changes.

� To remove view prefixes:

1. Select the Views page, using ADE in standalone mode, from the
Options window.

2. Select the view prefix to be deleted from the list.

3. Click the Remove Prefix button.

4. Click the Save button to save the changes. Use the Undo button to
cancel any changes.
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Specifying Environment Variables

The System Administrator can define a number of environment
variables with this command:

� SET HRIO_[value] = drive letter

Note:  If you are working with Windows 95 or 98 add the
command to AUTOEXEC.BAT.

Note:  If you are working with Windows NT add the setting to
your System Environment.

After you have modified either of these files you will need to reboot the
PC to make the new variable available to ADE.

� To specify the location of the Windows directory:

� SET HRIO_WINDIR=X:\ (where X is the drive letter).

ADE automatically locates the directory containing WINDOWS.
However, it is possible to override this using an environment
variable, for example if an installation has the windows directory
at a drive root level, for example on the network.

� To specify the location of the Windows system directory:

� SET HRIO_WINSYS=X:\ (where X is the drive letter).

This will only be required if the system directory is in a
non–standard location.  The systems directory is only used for
checking version numbers of the system files used by ADE.

� To specify a new location for the ADE.INI file:

� SET HRIO_ADEDIR=X:\ (where X is the drive letter).

This defines a new location for the ADE.INI file, which is useful
when sharing ADE.INI.

� To specify a new location for the ADE and Diagrammer Help files:

� SET HRIO_HELP=X:\ (where X is the drive letter).

� To generate the HRIO.DBG file:

� SET HRIO_TRACE=X:\ (where X is the drive letter).

This switches on the generation of a file called HRIO.DBG in the
ADE temporary directory. The HRIO.DBG file contains valuable
information about the actions performed by ADE. Additionally,
this environment variable enables the creation of:
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HRIO.SQL which contains any query performed

HRIO.API which contains any calls to an API during upload
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Testing ADE Settings

� To test ADE settings:

1. Click the Test button on the Options window in standalone mode.

2. Select a Style.

3. Click the OK button.



5 – 58 Using Application Data Exchange and Hierarchy Diagrammers

Setting the Display Mode for ADE Windows

ADE has several display options you can choose. By default, ADE
windows are displayed on top of all other application windows but
you can also choose to have ADE appear only when it is the active
window.

� To set the display mode for ADE windows:

1. Select the Paths page, using ADE in standalone mode, from the
Options window.

2. Choose a display option by selecting the appropriate radio button:

• On Top

Windows are always displayed on top of all other application
windows displayed on your desktop. This is the default option.

• Floating

Windows are displayed in the usual mode for Microsoft
Windows applications. An ADE window only appears on top of
other application windows when it is the active window.

3. Click the Save button to save your changes.

4. Click the Back button to save your changes to the ADE settings file.
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Debugging ADE

ADE can record a log of all actions. The log is saved in a file called
HRIO.DBG. The log is used by Oracle Worldwide Support, Oracle
Consultants, or users creating views and styles to help resolve
difficulties you may encounter with ADE.

� To Enable Trace Mode:

� Set this variable in AUTOEXEC.BAT:

SET HRIO_TRACE=ON
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Displaying the Version Number

� To find the ADE version number:

� Click the About button in the ADE Options window, or double
click the title banner on any ADE window, using ADE in
standalone mode.

� Right click the HRIOMAIN.exe in Windows Explorer and select the
Version Tab.
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Introduction to  Hierarchy Diagrams
You view hierarchy diagrams for  organizations and positions by using
the Oracle HRMS Hierarchy Diagrammers.

What Types of Hierarchy Can You Create?

You create organization and position hierarchies to reflect reporting
lines and control access to information in your enterprise:

• Organization hierarchies show reporting lines and other
hierarchical relationships between organizations in an enterprise.

• Position hierarchies show line management reporting in each
organization or throughout the enterprise, where you use
positions to define roles.

You can set up a primary hierarchy and as many secondary hierarchies
as required to show all the reporting lines and other hierarchical
relationships in your enterprise.

Can You See a Graphical View of the Hierarchies in Oracle HRMS?

Yes.  There are two Hierarchy Diagrammers that allow graphical
display and manipulation of hierarchies.  They are:

• The Organization Hierarchy Diagrammer

• The Position Hierarchy Diagrammer.

Is it Easy to Create and Maintain Hierarchies with the Diagrammers?

Yes.  You launch the Hierarchy Diagrammers within Oracle HRMS, so
you can create hierarchies and then make intuitive drag–and–drop
changes.  Although you can also make these changes by using the
forms in Oracle HRMS, the Hierarchy Diagrammers provide you with
an easier alternative.  Any changes made using the Hierarchy
Diagrammers are also reflected in HRMS forms, and are stored in your
database.

You can additionally:

• Create new versions of existing hierarchies

• Copy existing hierarchies to create new ones

• Create future–dated hierarchies to prepare for reorganizations in
advance

• Print pictorial representations of organization and position
hierarchies
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Overview

Setting Up the Hierarchy Diagrammers

The security features for the Hierarchy Diagrammers restrict your
access to them.  Depending on the access rights you are granted by
your system administrator:

• You may not have access to launch or use either of the Hierarchy
Diagrammers.

• You may be able to launch one or both of the Hierarchy
Diagrammers to view existing organization or position
hierarchies.  If you only have access to view hierarchies, you are
prevented from creating or modifying hierarchies.

• You may be able to launch one or both of the diagrammers to
view, create or modify organization or position hierarchies.

The Hierarchy Diagrammers use the same security model as Oracle
HRMS and access to them is restricted by your responsibility.   Your
system administrator must include functions on the menu for your
responsibility to enable you to access these options.

The Hierarchy Diagrammers are launched within Oracle HRMS from
Application Data Exchange (ADE).  You must have ADE installed and
set up so that you can use the diagrammers.  By default, you cannot
launch the Hierarchy Diagrammers from ADE. The options for the
diagrammers appear greyed out on the ADE Fetch Data window, if
your system administrator has not set up the diagrammers so you can
use them.

The functions that are predefined for controlling access to the
Organization or Position Hierarchy Diagrammers are as follows:

• HRIO View Organization –  allows you to launch the
Organization Hierarchy Diagrammer to display existing
organization hierarchies; you are prevented from creating or
modifying organization hierarchies.

• HR Update Organization –  allows you to launch the
Organization Hierarchy Diagrammer to create and modify
organization hierarchies.

• HRIO View Position – allows you to launch the Position
Hierarchy Diagrammer to display existing position hierarchies;
you are prevented from creating or modifying position
hierarchies.
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• HRIO Update Position –  allows you to launch the Position
Hierarchy Diagrammer to create and modify position
hierarchies.

You must also define the paths for the diagrammers within ADE.  Your
system administrator may define these as part of the set up for ADE.
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Menu and Toolbar Commands

The following commands can be accessed from the Hierarchy
Diagrammer menus.  They enable you to create, edit, save and print
hierarchy diagrams and control the display of hierarchy diagrams on
your desktop.

Some of these commands can also be accessed from the toolbar, which
provides quick access to commands you use often.

New (File menu/Toolbar)

Opens an empty diagram window for the current hierarchy
diagram to enable you to display multiple views of the diagram.  to
create a new view of the hierarchy, drag an organization or position
from the Hierarchy Values window to the new window.  All
changes made in the new window are also displayed in the main
window.  You can also select this command from the toolbar.

Open (File menu/Toolbar)

Opens a new diagram window displaying the current hierarchy
diagram to enable you to display multiple views of a diagram.  The
position or organization highlighted in the main window when you
select the command, is displayed at the top level in the new
window.  All changes made in the new window are also displayed
in the main window.  You can also select this command from the
toolbar.

Close (File menu)

Closes the current hierarchy diagram, without prompting you to
save.

Save (File menu/Toolbar)

Saves changes made to the hierarchy to your database.

Print (File menu/Toolbar)

Prints the hierarchy diagram displayed in the active diagram
window.

Print Preview (File menu)

Shows how the hierarchy diagram will look before you print it.
Use the command buttons to change the view of the diagram.  You
can also print the diagram directly from the Print Preview window.

Print Setup (File menu)

Enables you to change the printer settings.  You can select a printer
and printing options, and change the default printer.
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New Structure (File menu)

Enables you to create a new organization or position hierarchy.
You can create a new version of an existing hierarchy and copy an
existing hierarchy to create a new one.

Exit (File menu)

Exits the Hierarchy Diagrammer and prompts you to save any
changes.

Remove (Edit menu/Toolbar)

Removes the highlighted organization or position from the current
hierarchy and any subordinate organizations or positions.  Only
removes organizations and positions from the hierarchy and does
not delete them from your database.  You cannot remove the top
level organization or position.

Undo All (Edit menu/Toolbar)

Undoes all changes since your last save.

Background Color (Edit menu)

Enables you to change the background color for diagram windows.

Line Color (Edit menu)

Enables you to change the color of the connecting lines in hierarchy
diagrams.

Font (Edit menu)

Enables you to change the font, font style and size for the name
labels displayed on the hierarchy diagram.  The default font is the
System font.

Node Properties (Edit menu/Toolbar)

Enables you to change the color, text color, and shape of all the
nodes displayed on a hierarchy diagram.

Erase Window (View menu)

Erases the contents of the current hierarchy diagram window.
Only removes the display; it does not make changes to your
database.

Horizontal (View menu/Toolbar)

Changes the view of the current hierarchy diagram to an
organization chart style layout.

Vertical (View menu/Toolbar)

Changes the view of the current hierarchy diagram to a stacked
hierarchical layout.
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Column (View menu/Toolbar)

Changes the view of the current hierarchy diagram to an expanded,
stacked hierarchical layout.

Zoom In (View menu/Toolbar)

Enlarges the current hierarchy diagram.

Zoom Out (View menu/Toolbar)

Shrinks the current hierarchy diagram.

Toolbar (View menu)

Toggles the toolbar on and off.

Status Bar (View menu)

Toggles the status bar at the bottom of the main Hierarchy
Diagrammer window on and off.

Help (Help menu/Toolbar)

Displays help for using the Hierarchy Diagrammer.
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Displaying Hierarchy Diagrams

You display a hierarchy diagram in the Hierarchy Diagrammer by
selecting an Organization or Position Structure and the Version of the
structure from the lists displayed at the top.  The Hierarchy
Diagrammer includes a built–in editor to enable you to graphically
view, create and modify hierarchy structures.

The Hierarchy Diagrammer displays two types of windows:

• The Hierarchy Values window that displays all the organizations
or positions defined for a hierarchy.

• The Hierarchy Diagrammer window for viewing, creating and
modifying hierarchy diagrams.

Hierarchy Values Window

The Hierarchy Diagrammer uses the following symbols to show the
relationships between positions or organizations displayed in the
Hierarchy Values window.

Figure 6 – 1Symbols in the Hierarchy Values Window

You can only display one Hierarchy Values window in a Hierarchy
Diagrammer.

Hierarchy Diagram Window

The Hierarchy Diagram window displays a diagrammatic
representation of an organization or position hierarchy.  You use the
Hierarchy Diagram window to graphically view, create or modify an
organization or position hierarchy.  You can view several Hierarchy
Diagrams windows at a time, displaying different views of a hierarchy,
so that you can drill down from the top level to the lowest levels in a
hierarchy.

� To display a hierarchy diagram:

� Click and drag an organization or position from the Hierarchy
Values window and drop it into the adjacent Hierarchy Diagram
window.
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The organization or position is displayed with all its subordinates.
It is taken as the top level in the hierarchy and higher level
organizations or positions are not displayed.

� To display multiple views of a hierarchy diagram:

� Click on an organization or position that will represent the top level
in the hierarchy view, than choose Open from the File menu.

Each view of the hierarchy is displayed in its own Hierarchy
Diagram window.
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Expanding and Collapsing Diagrams

Each organization or position in a hierarchy diagram includes a small
button for expanding or collapsing diagrams.  The functions are:

Collapsible parent organization or position with
subordinates displayed. Double–click the
button to collapse subordinate organizations or
positions.

Expandable parent organization or position
with hidden subordinates. Double–click the
button to expand the parent and display
subordinate organizations or positions.

Organization or position with no subordinates.
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Using the Menus

Use the Hierarchy Diagrammer menus to create, edit, save and print
hierarchy diagrams and control the display of hierarchy diagrams on
your desktop.

Menu Summary

• The File  menu: page 6 – 12 provides commands for opening and
closing hierarchy diagram windows, saving and printing a
hierarchy diagram.  It also includes a command for creating a
new hierarchy diagram.

• The Edit menu: page 6 – 14 provides commands for undoing
changes, removing an organization or position and its
subordinates, and selecting the display preferences for hierarchy
diagrams.

• The View menu: page 6 – 15 provides commands for changing
the display within a Hierarchy Diagrammer.

• The Window menu provides commands for changing the display
of windows in a Hierarchy Diagrammer.

• The Help menu provides help for using a Hierarchy
Diagrammer.
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Using the File Menu

The File menu provides commands for opening and closing hierarchy
diagram windows, and for saving and printing hierarchy diagrams.  It
also includes a command to enable you to create a new hierarchy
diagram from an existing diagram.

Some of these commands can also be accessed from the toolbar, which
provides quick access to commands you use often.

Summary of Commands

New (Toolbar)

Opens an empty diagram window for the current hierarchy
diagram to enable you to display multiple views of the diagram.  to
create a new view of the hierarchy, drag an organization or position
from the Hierarchy Values window to the new window.  All
changes made in the new window are also displayed in the main
window.

Open (Toolbar)

Opens a new diagram window displaying the current hierarchy
diagram to enable you to display multiple views of a diagram.  The
position or organization highlighted in the main window when you
select the command, is displayed at the top level in the new
window.  All changes made in the new window are also displayed
in the main window.

Close

Closes the current hierarchy diagram, without prompting you to
save.

Save (Toolbar)

Saves changes made to the hierarchy to your database.

Print (Toolbar)

Prints the hierarchy diagram displayed in the active diagram
window.

Print Preview

Shows how the hierarchy diagram will look before you print it.
Use the command buttons to change the view of the diagram.  You
can also print the diagram directly from the Print Preview window.

Print Setup

Used to change the printer settings.  You can select a printer and
printing options, and change the default printer.



6 – 13Introduction to Hierarchy Diagrammers

New Structure

Enables you to create a new organization or position hierarchy.
You can create a new version of an existing hierarchy and copy an
existing hierarchy to create a new one.

Exit

Exits the Hierarchy Diagrammer and prompts you to save any
changes.
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Using the Edit Menu

The Edit menu provides commands for undoing changes, removing an
organization or position and its subordinates, and selecting the display
preferences for hierarchy diagrams.

Some of these commands can also be accessed from the toolbar, which
provides quick access to commands you use often.

Remove (Toolbar)

Removes the highlighted organization or position from the current
hierarchy and any subordinate organizations or positions.  Only
removes organizations and positions from the hierarchy and does
not delete them from your database.  You cannot remove the top
level organization or position.

Undo All (Toolbar)

Undoes all changes since your last save.

Background Color

Enables you to change the background color for diagram windows.

Line Color

Enables you to change the color of the connecting lines in hierarchy
diagrams.

Font

Enables you to change the font, font style and size for the name
labels displayed on the hierarchy diagram.  The default font is the
System font.

Node Properties (Toolbar)

Enables you to change the color, text color, and shape of all the
nodes displayed on a hierarchy diagram.
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Using the View Menu

The View menu provides commands for changing the display within a
Hierarchy Diagrammer.

Some of these commands can also be accessed from the toolbar, which
provides quick access to commands you use often.

Erase Window

Erases the contents of the current hierarchy diagram window.
Only removes the display; it does not make changes to your
database.

Horizontal (Toolbar)

Changes the view of the current hierarchy diagram to an
organization chart style layout.

Vertical (Toolbar)

Changes the view of the current hierarchy diagram to a stacked
hierarchical layout.

Column (Toolbar)

Changes the view of the current hierarchy diagram to an expanded,
stacked hierarchical layout.

Zoom In (Toolbar)

Enlarges the current hierarchy diagram.

Zoom Out (Toolbar)

Shrinks the current hierarchy diagram.

Toolbar

Toggles the toolbar on and off.

Status Bar

Toggles the status bar at the bottom of the main Hierarchy
Diagrammer window on and off.
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Using the Toolbar

Use the toolbar for quick access to commands you use often.  The
toolbar provides an alternative way of using commands included on
the Hierarchy Diagrammer menus.

The following commands (from left to right) are included on the
toolbar:

New (File menu)

Opens an empty diagram window for the current hierarchy
diagram to enable you to display multiple views of the diagram.  to
create a new view of the hierarchy, drag an organization or position
from the Hierarchy Values window to the new window.  All
changes made in the new window are also displayed in the main
window.

Open (File menu)

Opens a new diagram window displaying the current hierarchy
diagram to enable you to display multiple views of a diagram.  The
position or organization highlighted in the main window when you
select the command, is displayed at the top level in the new
window.  All changes made in the new window are also displayed
in the main window.

Save (File menu)

Saves changes made to the hierarchy to your database.

Print (File menu)

Prints the hierarchy diagram displayed in the active diagram
window.

Remove (Edit menu)

Removes the highlighted organization or position from the current
hierarchy and any subordinate organizations or positions.  Only
removes organizations and positions from the hierarchy and does
not delete them from your database.  You cannot remove the top
level organization or position.

Undo All (Edit menu)

Undoes all changes since your last save.

Node Properties (Edit menu)
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Enables you to change the color, text color, and shape of all the
nodes displayed on a hierarchy diagram.

Horizontal (View menu)

Changes the view of the current hierarchy diagram to an
organization chart style layout.

Vertical (View menu)

Changes the view of the current hierarchy diagram to a stacked
hierarchical layout.

Column (View menu)

Changes the view of the current hierarchy diagram to an expanded,
stacked hierarchical layout.

Zoom In (View menu)

Enlarges the current hierarchy diagram.

Zoom Out (View menu)

Shrinks the current hierarchy diagram.

Help (Help menu)

Displays help for using the Hierarchy Diagrammer.
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Launching a Hierarchy Diagrammer

You launch the Hierarchy Diagrammers from within Oracle HRMS
using ADE (Application Data Exchange).  ADE enables you launch
other applications including the Organization Hierarchy Diagrammer
and the Position Hierarchy Diagrammer.  Once launched, the Hierarchy
Diagrammers run in their own window on your PC desktop.

� To launch a Hierarchy Diagrammer:

1. In Oracle HRMS, click the ADE icon on your application toolbar to
launch ADE.

2. Using the ADE Fetch Data window, select the option for the
Hierarchy Diagrammer you want to use.

3. Choose the Start button to launch the Hierarchy Diagrammer.
ADE is iconized while the diagrammer is running.
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Creating an Organization or Position Hierarchy

Use the Hierarchy Diagrammers to graphically create an organization
or position hierarchy.

You can create a new hierarchy by:

Setting Up a New Hierarchy: page 6 – 20

Creating a New Version of an Existing Hierarchy: page 6 – 21

Copying an Existing Hierarchy: page 6 – 22
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Setting Up a New Hierarchy

Use the Hierarchy Diagrammers to graphically set up a new
organization or position hierarchy.  You must firstly define all the
organizations or positions for the hierarchy and create the hierarchy
within Oracle HRMS to specify:

• A unique name for the hierarchy

• The version number and start date for the hierarchy

• The top organization or position in the hierarchy

• The subordinate organizations or positions for the hierarchy.

You do not need to define the position of subordinates relative to each
other in the hierarchy; the Hierarchy Diagrammers provide a graphical
tool to place subordinates in an organization or position hierarchy.

See: Creating an Organization, and Creating Organization
Hierarchies in Using Oracle HRMS – The Fundamentals, or

See: Defining a Position, and Creating a Position Hierarchy in Using
Oracle HRMS – The Fundamentals

� To set up a new organization or position hierarchy:

1. In Oracle HRMS, launch a Hierarchy Diagrammer..

2. Select an Organization or Position Structure from the list and the
version number for the hierarchy.

3. In the Hierarchy Values window, select the organization or position
that represents the top level in the hierarchy and drag it to the
Hierarchy Diagram window.

4. Build the hierarchy by adding organizations or positions, working
from the top level down.

• To add an organization or position, drag it from the Hierarchy
Values window to the organization or position that will be its
parent and drop it on top to add it to the hierarchy.  The cursor
displays a small rectangle when you are on top of the parent
value.

• You can move and remove organizations or positions to modify
the hierarchy until you have the correct structure.

5. Save your hierarchy.  The Hierarchy Diagrammer commits the
changes to your database to create the new hierarchy.
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Creating a New Version of an Existing Hierarchy

Use the Hierarchy Diagrammers to create a new version of an existing
organization or position hierarchy.

� To create a new version of an existing hierarchy:

1. In Oracle HRMS, launch a Hierarchy Diagrammer.

2. Select New Structure from the File menu to display the Structure
Version window.

3. Select the name of an existing hierarchy.

The version number for the new hierarchy is automatically
defaulted to create a new version following on from the previous
one.  The start date for the new version is taken as  today’s date,
but you can modify the date, for example, to create future–dated
versions.

Note:  Overlapping versions of a hierarchy cannot exist.  When
you create a new version of an existing hierarchy, the system
automatically gives an end date to the existing version.  Oracle
HRMS retains all previous versions of hierarchies for historical
information.

You can also create a new hierarchy by copying an existing
hierarchy and modifying it.

4. Modify the hierarchy to add, move or remove organizations or
positions to create the new hierarchy.

5. Save your hierarchy.  The Hierarchy Diagrammer commits the
changes to your database to create the new hierarchy.
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Copying an Existing Hierarchy

Use the Hierarchy Diagrammers to create a new organization or
position hierarchy by copying an existing one.

� To copy an existing hierarchy:

1. In Oracle HRMS, launch a Hierarchy Diagrammer.

2. Select New Structure from the File menu to display the Structure
Version window.

3. Enter or select a name for your new hierarchy.

If you enter a new, unique name for your hierarchy, the version
number automatically defaults to 1.  If you select the name of an
existing hierarchy, the version number is defaulted to create a new
version following on from the previous one.  The start date for the
new version is taken as today’s date.  You can modify the date, for
example, to create future–dated versions.

4. Modify the hierarchy to add, move or remove organizations or
positions to create the new hierarchy.

5. Save your hierarchy.  The Hierarchy Diagrammer commits the
changes to your database to create the new hierarchy.
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Modifying an Organization or Position Hierarchy

Use the Hierarchy Diagrammers to graphically change your hierarchies
to reflect changes in reporting lines or access to information.

You can modify an organization or position hierarchy by:

Adding Organizations or Positions to a Hierarchy: page 6 – 24

Moving Organizations or Positions in a Hierarchy: page 6 – 26

Removing Organizations or Positions From a Hierarchy: page
6 – 25
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Adding Organizations or Positions to a Hierarchy

Use the Hierarchy Diagrammers to add organizations or positions to an
organization or position hierarchy.

� To add organizations or positions to a hierarchy:

1. In Oracle HRMS, launch a Hierarchy Diagrammer.

2. Select an Organization or Position Structure from the list and the
version number for the hierarchy you want to modify.

3. Select the top level organization or position for the hierarchy from
the Hierarchy Values window and drag it to the Hierarchy
Diagram window.

The top level organization or position is displayed with all its
descendants.

4. In the Hierarchy Values window, select the organization or position
you want to add to your hierarchy, drag it to the organization or
position that will be its parent and drop it on top to add it to the
hierarchy.

The cursor displays a small rectangle when you are on top of the
parent value.

5. Save your changes to the hierarchy.  The Hierarchy Diagrammer
commits the changes to your database.
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Removing Organizations or Positions From a Hierarchy

Use the Hierarchy Diagrammers to remove organizations or positions
from an organization or position hierarchy.

� To remove organizations or positions from a hierarchy:

1. In Oracle HRMS, launch a Hierarchy Diagrammer.

2. Select an Organization or Position Structure from the list and the
version number for the hierarchy you want to modify.

3. Select the top level organization or position for the hierarchy from
the Hierarchy Values window and drag it to the Hierarchy
Diagram window.

The top level organization or position is displayed with all its
descendants.

4. Select the organization or position you want to delete from your
hierarchy, and drag and drop it into the Hierarchy Values window,
or press the Delete key to remove it and all its descendants.

You are not deleting the organization or position from your
database; you are just removing it from the hierarchy.

5. Save your changes to the hierarchy.  The Hierarchy Diagrammer
commits the changes to your database.
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Moving Organizations or Positions in a Hierarchy

Use the Hierarchy Diagrammers to move organizations or positions in
an organization or position hierarchy.

� To move organizations or positions in a hierarchy:

1. In Oracle HRMS, launch a Hierarchy Diagrammer.

2. Select an Organization or Position Structure from the list and the
version number for the hierarchy you want to modify.

3. Select the top level organization or position for the hierarchy from
the Hierarchy Values window and drag it to the Hierarchy
Diagram window.

The top level organization or position is displayed with all its
descendants.

4. Select the organization or position you want to move in your
hierarchy, drag it to the organization or position that will be its
parent and drop it on top to add it to the hierarchy.

The cursor displays a small rectangle when you are on top of the
parent value.

5. Save your changes to the hierarchy.  The Hierarchy Diagrammer
commits the changes to your database.
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Glossary

A
Application Mode  An ADE session which

you launch from within Oracle applications
 

Assignment Status  For employees, used to
track their permanent or temporary
departures from your enterprise, and to
control the remuneration they receive.  For
applicants, used to track the progress of
their applications.

B
Block  The largest subordinate unit of a

window, containing information for a
specific business function or entity.  Every
window consists of at least one block.
Blocks contain fields and, optionally,
regions.  They are delineated by a bevelled
edge.  You must save your entries in one
block before navigating to the next.  See
also: Region, Field

Business Group  The highest level
organization in the Oracle HRMS system.
A Business Group may correspond to the
whole of your enterprise or to a major
grouping such as a subsidiary or operating
division.  Each Business Group must
correspond to a separate implementation of
Oracle HRMS.

C
Comparison Operator  A symbol that allows

you to specify a range of values for a query
condition. For example, the comparison
operator  > will select all values greater
than the value that you specify.

 

D
DateTrack  When you change your effective

date (either to past or future), DateTrack
enables you to enter information that takes
effect on your new effective date, and to
review information as of the new date.  See
also: Effective Date

 
Default Queries  Queries based on the last

forms query made within Oracle
Applications.

E
Effective Date  The date for which you are

entering and viewing information.  You set
your effective date in the Alter Effective
Date window.  See also: DateTrack
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F
Field  A view or entry area in a window where

you enter, view, update, or delete
information.  See also: Block, Region

Folder Window  A special block or window
whose field and record layout you can
customize.  You can identify a folder block
by the Open Folder icon in the upper left
corner.  You can save your customized field
and record layout as a new folder.

Form  A predefined grouping of functions,
called from a menu and displayed, if
necessary, on several windows.  Forms
have blocks, regions and fields as their
components.  See also: Block, Region, Field

FORM Style  Allows the export of a record or
set of records from a specified window
when using ADE in application mode

G
GENERAL Style  Allows the export of data

directly from the Oracle Applications
database when using ADE in standalone
mode. The General Style includes an SQL*
plus script and the data is retrieved by a
view on the server..

L
LETTER Style  Allows the export of data for

mail merge when using ADE in letter
request mode.

Letter Request Mode  An ADE session which
allows you to export recruitment and
enrollment data for mail merge.

Q
Queries The enquiries by which you retrieve

information from Oracle Applications.  

Query Condition A qualifying statement or
set of statements which refine the
information retrieved by a query.

Query Value  The specific detail attached to a
query condition. For example, the query
condition of City  could have the query
value of Boston

R
Region  A collection of logically related fields

in a window, set apart from other fields by
a rectangular box or a horizontal line across
the window.  See also: Block, Field

Responsibility  A level of authority in an
application.  Each responsibility lets you
access a specific set of Oracle Applications
forms, menus, reports, and data to fulfill
your business role.  Several users can share
a responsibility, and a single user can have
multiple responsibilities.  See also: Security
Profile, 

S
Security Profile  Security profiles control

access to organizations, positions and
employee and applicant records within the
Business Group.  System administrators use
them in defining users’ responsibilities.  See
also: Responsibility 

Standalone Mode  A session in which you log
into ADE independently rather than
launching ADE from Oracle applications .

 
Style  A specification of the data that you can

export  for a query.
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Style Definition  Determines the data
retrieved by the query, the format of the
exported data, the responsibility that can
use the style, and whether the style is
enabled for upload.

V
View   A definition of the data that will be

retrieved for a standalone query.  Query
views export data from the application to a
spreadsheet. List of Value views are used in
standalone queries to display a list of
values.
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Index
A
Access

for updating hierarchies, 6 – 3
for viewing hierarchies, 6 – 3

Adding
organizations to hierarchy, 6 – 24
positions to hierarchy, 6 – 24

ADE
business purpose, 1 – 2
compatible products, 1 – 4
functionality, 1 – 2
initialization file (ADE.INI), 5 – 16
Installation, 5 – 23
platforms, 1 – 4
version number, displaying, 5 – 60

AOL security, 5 – 20
APIs, Supplied with ADE, 5 – 16
Application mode, when to use, 1 – 3
Applications data, editing and uploading, 3 – 4

B
Business purpose of ADE, 1 – 2

C
Commands, for menus and toolbar, 6 – 5
Comparison operators, 2 – 4

Controlling access, 6 – 3
Copying, existing hierarchy, 6 – 22
Creating

a position hierarchy, 6 – 19
an organization hierarchy, 6 – 19
new version of existing hierarchy, 6 – 21

Creating views for standalone queries, 5 – 6

D
Data Upload, 3 – 4
Debugging ADE, 5 – 59
Displaying hierarchy diagrams, 6 – 8

collapsing diagrams, 6 – 10
expanding diagrams, 6 – 10
multiple views, 6 – 9

E
Environment variables, specifying, 5 – 55
Existing hierarchy

copying, 6 – 22
creating a new version from, 6 – 21
modifying, 6 – 23

Exporting data, in application mode, 2 – 14
Exporting data in standalone mode

overview, 2 – 3
specifying search conditions, 2 – 6



Index – 6 Using Application Data Exchange and Hierarchy Diagrammers

without specifying conditions, 2 – 3

F
Floating display mode, 5 – 58
Forms 6.0/ADE Communication file, 5 – 19
Functionality of ADE, 1 – 2
Functions, defining, 5 – 21
Functions and AOL security, 5 – 20

I
Installation, 5 – 23

on PC without shared network drive, 5 – 43
InstallShield, 5 – 28

L
Launching a Hierarchy Diagrammer, 6 – 18
Launching ADE in Standalone Mode,

overview, 1 – 5
Launching another application from ADE, 1 –

7
Letter Request mode, when to use, 1 – 3
Letter request setup, for recruitment and

enrollment, 4 – 4
List of Values View, example of, 5 – 11

M
Mail merge, choosing a mail merge document,

4 – 5
Menus

Edit menu, 6 – 14
File menu, 6 – 12
Help menu, 6 – 11
summary of commands, 6 – 5
using, 6 – 11
View menu, 6 – 15
Window menu, 6 – 11

Miscellaneous options, 5 – 31

Modes of working with ADE, 1 – 3
Modifying

organization hierarchy, 6 – 23
position hierarchy, 6 – 23

Moving
organizations in hierarchy, 6 – 26
positions in hierarchy, 6 – 26

N
New version, creating from existing hierarchy,

6 – 21
Node properties, for diagrams, 6 – 16

O
On Top display mode, 5 – 58
Operating systems for ADE, 1 – 4
Operators, 2 – 4
Overview of Hierarchy Diagrammers, 6 – 2

P
Parameters for Discoverer , 5 – 15
Parameters for the Diagrammers, 5 – 15
Parameters passed to ADE, 5 – 13
Paths, defining for diagrammers, 6 – 4
Prefixes, Setting for views, 5 – 54
Previewing exported data, 2 – 4
Printing, a query, 2 – 12

Q
Query view, example of, 5 – 9

R
Removing

organizations from hierarchy, 6 – 25
positions from hierarchy, 6 – 25
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S
Saved queries

deleting, 2 – 11
loading, 2 – 11
rerunning, 2 – 11

Saved Query Files, format of, 5 – 18
Saving a query, 2 – 10
Security

features for restricting access, 6 – 3
including menu functions, 6 – 3

Security and control, responsibilities and
styles, 5 – 3

Selecting a query, 2 – 5
Setting up, 6 – 3

a new hierarchy, 6 – 20
ADE to launch diagrammers, 6 – 3
security features for diagrammers, 6 – 3

Setup, overview, 5 – 7
Setup steps

introduction, 5 – 7
Step 1: Run InstallShield, 5 – 28
Step 10: Define Letter Types, 5 – 38
Step 11: Creating Views for Letter Requests,

5 – 39
Step 12: Creating Styles for Letter Requests,

5 – 40
Step 13: Creating a Mail Merge document

(all standard letters), 5 – 41
Step 2: Define Paths, 5 – 29
Step 3: Set Miscellaneous Options, 5 – 31
Step 4: Define Menus, 5 – 32
Step 6: Create Views for Standalone Queries,

5 – 34
Step 7: Prepare Scripts for APIs, 5 – 35
Step 8: Create Styles for Standalone Queries,

5 – 36
Step 9: Create Styles for Application Mode

Queries, 5 – 37
Shadow view, example of, 5 – 10
Specifying a query value, 2 – 9
Specifying data order for search conditions, 2 –

7
Specifying environment variables, 5 – 55

Spreadsheets, product versions compatible
with ADE, 1 – 4

Standalone mode, when to use, 1 – 3
Standard letters, for recruitment and

enrolment, 4 – 3
Standard letters and reports

(other than recruitment and enrollment), 4 –
3

overview, 4 – 3
Style definitions, what is included in a style

definition, 5 – 4
Styles, Supplied with ADE, 5 – 15

T
Testing ADE settings, 5 – 57
Toolbar

summary of commands, 6 – 5
using, 6 – 16

U
Uploading applications data, 3 – 4

V
Version number for ADE, displaying, 5 – 60
Views

List of Values View, example of, 5 – 11
Query view, example of, 5 – 9
Setting prefixes, 5 – 54
Shadow View, example of, 5 – 10
Supplied with ADE, 5 – 16

W
Windows

Hierarchy Diagram, 6 – 8
Hierarchy Values, 6 – 8

Word processors, product versions compatible
with ADE, 1 – 4
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